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Micro Focus Enterprise Developer 4.0 for
Visual Studio Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site for any
updates to the documentation which might have been uploaded.

Product Overview

Enterprise Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM
DB2, IBM z/OS file formats and common batch utilities, including SORT. This means that you can develop
and maintain the core mainframe online and batch applications under Enterprise Developer. You can then
deploy these applications back on the mainframe or migrate them onto one of the Micro Focus Linux, UNIX
or Windows-based production platforms.

Upgrading from earlier Micro Focus products

Version 4.0 of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with an earlier version of your
product might not be compatible with version 4.0 run-time products. If the behavior of your application
changes with version 4.0, we strongly recommend that you relink the main executable with version 4.0.
This will ensure that the COBOL run-time system fully handles any run-time error conditions that might
occur.

A new executable that is fully compatible with version 4.0 can be produced without recompiling the
application, as long as the original object code is available and it is relinked with version 4.0.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Enterprise Developer can automatically relink the existing executable or .dll to the new version of
the C run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar (Visual Studio 2015 and 2017) or a dialog box (Visual Studio
2013) providing an option for you to choose and relink the project.
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What's New
This release provides enhancements in the following areas:

• Integration with Visual Studio
• Application Server JCA Support for Enterprise Server
• Build Tools for Windows
• Code Coverage
• Codeset support
• Compiler directives
• Data File Tools
• Debugging
• Docker
• Documentation on working with large applications
• Enterprise Server
• Enterprise Server for .NET
• File Handler
• HCO for DB2 LUW
• IMS support
• JCL support
• Mainframe Access
• Library routines
• Micro Focus Unit Test Framework
• OpenESQL
• Platform support
• PL/I support
• Web Service Clients

Integration with Visual Studio

Back to Top

This release includes the following editor improvements:

• Inline rename refactoring - overwriting a variable name directly in the editor now invokes rename
refactoring so you no longer need to select Refactor from the editor context menu.

• Extract to section - a new quick action (Visual Studio 2015 and later only) is available in the editor. It
enables you to refactor your code by adding more sections in the code. This can help you create more
entry points that you can use during unit testing.

• Automatic insertion of END-EXEC, END-TRY and END-PERFORM statements - the closing statements
are now automatically inserted after you have typed the opening statements.

• IntelliSense filters (Visual Studio 2017 and later only) - when IntelliSense displays a list of suggestions,
a number of icons at the bottom of the IntelliSense window now enable you to filter the suggestions.

Working with files:

• Copybook graphs - a context menu command, Show Copybook Graph, in Solution Explorer enables
you to display the graphical representation of the copybook dependencies of COBOL programs.

• Open Folder mode (Visual Studio 2017 only) - support is now available for editing, compiling and
debugging files opened in Solution Explorer in Open Folder mode without having to create projects.

• The file property pages now display a list of all Compiler directives that apply to the file.

New IDE configuration option:

What's New | 5



• You can use the Limit IntelliSense Search Scope setting in Tools > Options > Text Editor > Micro
Focus COBOL > Advanced that helps improve the editor performance.

Relinking existing applications:

• You can now configure Enterprise Developer to check whether applications created with older releases
must be relinked. If the application uses an older version of the C runtime, Enterprise Developer can
automatically relink the existing executable or .dll to the new version of the C runtime without the need
to recompile the application first.

If a project needs relinking, Visual Studio displays a message in the status bar (Visual Studio 2015 and
2017) or a dialog box (Visual Studio 2013) providing an option for you to choose and relink the project.

Application Server JCA Support for Enterprise Server

Back to Top

This release includes the following enhancements:

• COBOL Resource Adapters now support WebSphere 9.0 and WebLogic 12.2.1.
• Tomcat 7.0 support for servlet generation with J2SEBeans.
• NullSearch utility - for COBOL resource adapters, this new utility provides assistance in locating NULL

fields in mappings passed to Enterprise Server. When a large number of arguments is provided in the
parameters passed to Enterprise Server, it is difficult to locate NULL fields, which are not allowed. The
NullSearch utility isolates NULL fields, so the Java application can be corrected.

Build Tools for Windows

Back to Top

This release includes Enterprise Developer Build Tools for Windows, a separately-installable component of
Enterprise Developer that has been designed to be used in environments where you want to work with your
COBOL and PL/I projects but you don't want the overheads associated with the Visual Studio IDE.

Build Tools provide a lightweight, easy-to-install development environment that is well-suited for use in
Docker containers and continuous integration or continuous delivery systems.

Code coverage

Back to Top

This release provides the following enhancements:

• In Visual Studio, the Micro Focus Code Coverage window now offers a File View in addition to the
existing Program View.

Codeset support

Back to Top

Support has been added to enable codeset mapping to additionally be configured to use IBM's Conversion
Tables directly instead of the Micro Focus supplied tables. You need to download IBM's conversion tables
from IBM's Web site. Then you can use the MFCODESET environment variable to convert between IBM's
CCSIDs.

Compiler directives

Back to Top

The following Compiler directives are new in this release:

• DISPSIGN - determines the display output of numeric fields with included signs, under an IBM
mainframe dialect only.
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• GNTLITLINKSTD - stops the suppression of call-convention 8 when both call-convention 2 and call-
convention 8 are in effect for a .gnt file in an Intel x86 32-bit environment.

• ILSMARTANNOTATE - adds attributes to the items generated by ILSMARTLINKAGE, based on their
data type, which can be used to identify the size or range of the item in COBOL.

• ILSMARTTRIM - trims any trailing spaces from a string item returned by the get property associated
with an alphanumeric item processed by ILSMARTLINKAGE.

• MAINFRAME-FLOATING-POINT - specifies the format of a program's floating point data items: either
IBM hexadecimal format or IEEE format. This directive is supported in managed code only.

The following Compiler directives contain new parameters in this release:

• CHECKDIV - a new parameter 'ACOS' now emulates a divide by zero operation on an ACOS
mainframe system: the quotient and the remainder are set to the value of the dividend.

• OOCTRL - a new parameter, L, specifies whether to include directory location comments in .cls
and .ins inheritance files.

• NUMPROC - a new parameter 'ACOS' provides partial compatibility with the behavior of NEC ACOS
COBOL processing of invalid data in USAGE DISPLAY data items and invalid sign information in
USAGE COMP-3 data items.

Data File Tools

Back to Top

It is now possible to export any filtered results. When filtering a data file, you can use the results to create a
new data file - click Search > Export Results when a filter is applied to save the filtered records to a new
file. You can:

• Save the filtered records to a new file.
• Save the records that match the specified filter (such as customer information or orders).
• Download a subset of the data from a remote file.
• Save a small portion of the data for testing purposes.

Debugging

Back to Top

This release includes the following enhancements:

• Enhanced .NET debugging in Visual Studio 2017 - a number of advanced debug features are now
available when debugging .NET COBOL code. Features include support for performance tips,
backwards debugging, an expression evaluator, integration with the Diagnostic Tools window, remote
debugging of .NET COBOL applications, as well as support for IntelliSense in the debug windows (such
as the Immediate, Watch, and QuickWatch windows).

• Debugging CICS channels and containers - you can now debug CICS COBOL applications that use
channels and containers. The debugger now enables you to view the contents of any channels and
containers, and to change content as you debug.

Docker

Back to Top

This release provides support to enable you to run your COBOL and PL/I applications in Docker
containers, taking advantage of the many benefits offered by the Docker platform such as portability,
performance, agility, isolation, and scalability.

Documentation on working with large applications

Back to Top

The product help now includes a new section, Working with a Large Code Base, that includes
recommendations and best practices for working with large applications inside the IDE. It includes tips on
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how to structure your projects, how to optimize the performance of the IDEs, and step-by-step workflow
showing how to move an existing legacy application into Enterprise Developer.

Enterprise Server

Back to Top

The following enhancements have been made to Enterprise Server:

• Conversation filtering - the Enterprise Server Communications Process (MFCS) can now restrict access
to listeners by client address. You can specify any permitted or forbidden addresses either by IP
address, network mask, or domain name, and use wildcards. Filters can be applied to individual
listeners, communications processes, or to entire regions. More specific filter rules override any general
ones.

• The Enterprise Server Security Facility now starts throttling Verify requests when it receives more than
100 requests per second.

This can be used to limit the effectiveness of denial-of-service and brute force attacks. You can
configure the value where throttling occurs. See Verify Request Throttling for more information.

• (Technology Preview only) Support for adding, deleting, and modifying XA resources in a live Enterprise
Server region.

It is now possible to add, edit, or delete XA resources while an enterprise server instance is running.
Any changes made come into effect after any in-flight transactions have completed. The ability to make
these changes in a live environment comes under the control of the existing enterprise server
permissions.

• XA-compliant Resources (XARs) - this release provides enhanced CTF tracing that allows more flexible
reporting of warnings and errors on the RM switch module level.

• A new Communications Server resource class - enables you to control the access to the Enterprise
Server Console Log and Communications Server Log when external security is in effect for an
enterprise server region; see Resource Classes for Communications Server for more information.

• Improved catalog availability - there is now an improved resilience to temporary communication issues
with the catalog and error reporting enabling a region to stay active if a region has multiple catalogs
defined and one of the catalogs is not available.

• Enhanced SSL/TLS certificate support - for communications with TLS (formerly SSL), additional
certificate and key file formats are supported. Servers may now be configured with both an RSA and an
ECC key and certificate.

• Enhanced SSL/TLS cipher configuration - for communications with TLS (formerly SSL), the permitted
cipher suites and their preferred order can now be configured. The minimum size of Diffie-Hellman
groups for DH key exchange can also be configured. The defaults have been made more secure.

• The Historical Statistics Facility (HSF) now enables you to write user-defined data to the records
produced within a .csv file. Use the ES_WRITE_CUSTOM_HSF or ESCSTHSF library routines within
your COBOL programs to define the custom data, and use the ES_HSF_CFG environment variable to
configure up to five custom fields in the generated record.

• You can also use the ES_HSF_CFG environment variable to configure the number of CICSF, TSQ, and
TDQ fields that are written to the record.

Enterprise Server for .NET

Back to Top

This release provides the following enhancements:

• Limited support has been added for TLS (SSL) - you can now configure TN3270 and MFBINP listener
channels for TLS (SSL). The seeout command-line utility and the JES public class API also now support
TLS.
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• Enterprise Developer for Visual Studio includes a new wizard that enables you to convert native MSS
projects to managed MSS ones. The wizard is invoked using the Create Managed Mainframe Project
context-menu command at project level in Solution Explorer.

File Handler

Back to Top

This release provides the following enhancements:

• The DFSORT and SYNCSORT emulations now support the NULLOFL parameter of the OUTFIL
statement.

• The ASCIISOSI configuration option is now available. It adds the required SOSI characters to the
relevant EBCDIC DBCS character strings in order for them to be displayed or written out correctly.

HCO for DB2 LUW

Back to Top

This release includes the following new features:

• Support for CHARSET EBCDIC COBOL stored procedures
• Seamless integration with DB2 LUW SBCS databases, providing various EBCDIC collation sequences
• 64-bit HCO command-line tools are now available across all supported platforms
• HCO DCLGEN enhancements that provide more copybook generation options

IMS support

Back to Top

This release introduces the following new features:

• The IMS Database Forward Recovery feature has been updated to provide point-in-time forward
recovery that enables you to recover all database transactions completed up to a specified point in time,
including date and time of day.

• IMS support now includes MFS code for Light Pen devices. In your MFS, include a DEV statement with
the FEAT=PEN parameter, and set the ATTR property on appropriate fields to DET or IDET to make
them detectable by a light pen. See your IBM documentation for details.

Note: MFS that contains light pen code must be regenerated to take effect if the MFS is part of an
Enterprise Developer project created using an earlier release.

• Support for export and import of IMS-configured enterprise server regions through Server Explorer.

JCL support

Back to Top

This release introduces the following new features and enhancements:

• Micro Focus FTP utility - you can now configure MFFTP to not process trailing blank spaces for a GET
command, by setting the new control variable MFFTP_PROCESS_TRAILS_ONGET=FALSE and
setting the LOCSTAT value TRAILINGBLANKS=FALSE.

• A new API has been introduced - MVSSPLPB - that enables you to search all job information held in the
JES spool control files. It is more comprehensive that the existing MVSCASPB API, and should instead
be used for all new spool enquiries.

• A number of new environment variables have been introduced that enable you to configure the JES
startup behavior with regards to opening user catalog files. You can configure JES to open user catalog
files only when they are required (and not during system startup), and you can configure JES to retry
opening a catalog file that has failed to open. These changes increase the resilience of the JES system,
as you can mitigate against JES startup failures if the user catalog files are not readily available whilst
the region starts. See Configuring Multiple Catalogs for more information.
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• The public catalog API, MVSCATPB, has been enhanced to better report on file errors when opening
catalog files. The following new functions have been added to mfpubcat.cpy: GCFS, GNFS, STNI,
GCFE, and GNFE.

Library routines

Back to Top

The following library routines contain new functionality:

• CBL_GET_OS_INFO - this library routine can now detect if the program is running within a Docker
container: cblte-osi-rts-capabilities parameter, bit 7.

Mainframe Access

Back to Top

The installation process has been changed as follows:

• A single installer for both Mainframe Access and the Mainframe Access z/Server support is provided.
• There is now only one XML configuration file for Mainframe Access. There is also a new configuration

utility that guides you through the configuration process.
• Specify your own JES console character - it is now possible to configure the Mainframe Access

installation to use a different JES console character instead of the default ("$"). To achieve this, use the
new JES_CONCHAR configuration parameter.

Enhancements are available in the following areas:

• The Mainframe Call Generator now runs in an independent address space. Previously, it was possible
for code run in the MFA address space to enter a supervisor state. MCGLIB is now the new address
space's STEPLIB. This enables other user modules to be called without placing them in MFA's
STEPLIB, as was previously necessary. See Mainframe Call Generator: Calling Programs on the
Mainframe for more information.

Micro Focus Unit Test Framework

Back to Top

This release provides support for the following functionality:

• Generation of unit test stubs for selected entry points within your program.
• Support has been added to Visual Studio for unit testing of managed procedural projects.

OpenESQL

Back to Top

This release provides the following new features:

• Support for SQL Server 2017.
• The SQL(TRANSACTION) compiler directive has been enhanced to clearly define transaction

boundaries.
• A new SQL(NOWHERECURRENT) compiler directive that allows you to define updateable cursors that

do not do positioned updates or deletes with PostgreSQL or MySQL.
• Larger communication area (PID) that accommodates longer plan and program names.
• SQL(OPTIMIZECURSORS) has been enhanced for consistent and better cursor performance across all

OpenESQL backends.

Platform support

Back to Top
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Note the following changes in platform support for this release:

• Windows 8 and Windows Server 2012 are no longer supported for developing applications. They are
still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are supported.

PL/I support

Back to Top

Note: PL/I applications that were created using Enterprise Developer 3.0 and earlier must be
recompiled in Enterprise Developer 4.0 to ensure they will compile and execute properly.

Support has been added to Eclipse for the following features in PL/I debugging:

• Displaying complex data structures in the Expressions and Variables views.
• Viewing the console window on non-Windows platforms so that output and input can be seen or

entered.
• The Outline view in the default Debug perspective.
• Watchpoints on variables on the line where the variable has been declared.
• Conditional breakpoints.
• Skipping variables a defined number of times before the execution stops.
• Adding expressions to the Expressions view from the Outline view.
• Inspecting variables when referenced as part of a macro argument.
• Signals and conditions.

PL/I compiler and Run-Time System enhancements:

• Support for the following built-in functions - CHARVAL(), COMPARE(), CURRENTSIZE(), EDIT(),
PICSPEC(), SOURCEFILE() and SOURCELINE().

• Support for additional DATETIME() format strings.
• Support for the FLUSH FILE(*), ITERATE, and RESIGNAL statement.
• Support for the XMLOMIT and XMOLATTR attributes on variable declarations.
• Support for the MARGINI compiler option.
• Support for the SIZE and STRINGSIZE prefix conditions.
• Improved support for the repeat factor on arrays of AREA variables.
• Improved pointer arithmetic on 64-bit platforms.
• Where necessary, MFPLX now recognizes selected *PROCESS statements and passes them to the

appropriate preprocessors.

PL/I macro preprocessor:

• The Micro Focus macro preprocessor now provides a new default behavior that mimics IBM's
RESCAN(ASIS) behavior. In addition, a new option, rescan_upper, has been introduced to enable you
to optionally mimic IBM's RESCAN(UPPER) behavior.

Improvements in compatibility with IBM's Macro Preprocessor:

• Allows OTHER as an acceptable abbreviation for OTHERWISE on a macro SELECT statement.
• Supports the SCAN/NOSCAN option on declaration of macro variables.
• Implements the NOSCAN option on ANSWER statements.
• The %NOTE message format has been modified to match IBM's behavior.
• The SYSVERSION built-in function has been modified to always return a value of 22 bytes in length

(space padded, if necessary).
• Relaxed diagnostics for scenarios where Enterprise Developer is generating a warning message and

IBM does not.

(Technical Preview) Interaction with COBOL AMODE and 370 Assembler programs (Windows 32-bit only):
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• A new compiler option is available which enables Open PL/I to interact with 370 Assembler, and with
COBOL programs compiled with AMODE. See the product help for the current limitations to this
support.

Web service clients

Back to Top

This release provides the following enhancements for Web service clients:

• Improved support for larger, more-complex WSDL files, including:

• Configurable generation of variable arrays and repeated structures by specifying the Inline-Array-
Size-Limit parameter.

• Generation selection for service, port, and one or more operations.
• Support for SOAP version 1.2 in addition to version 1.1.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• Application Server JCA Support
• CICS Support
• Code Coverage
• Codeset Support
• Common Communications Interface
• Communications Server
• Compiler
• Data Tools
• Documentation
• Enterprise Server
• Enterprise Server Auditing
• Executables require relinking
• File Handling
• HCO for Microsoft SQL Server
• JCL Support
• Mainframe Access
• MF Server Administrator (GUI)
• Micro Focus Directory Server
• PL/I Compiler
• Run-Time System

Application Server JCA Support for Enterprise Server

• With this release, all CICS-related Java artifacts have been delivered using a new directory structure
under the javaee-ccl directory of your Enterprise Developer installation directory. The javaee-ccl
directory structure mimics the structure of the javaee directory. For example, mfccl.jar is no longer
located in the bin subdirectory, but can be found in the javaee-ccl\common directory.

CICS Support

Back to the list

• Starting with version 4.0 Patch Update 2, all applications that use WEB CONVERSE or WEB SEND
SESSTOKEN explicitly with the AUTHENTICATE, BASICAUTH, or NONE options, and that do not use a
URIMAP that specifies the AUTHENTICATE attribute, must be recompiled. (This does not affect
applications that use a URIMAP that specifies the AUTHENTICATE attribute.)

• Client ECI timeouts now propagate CTG requests to ABEND AITH the ECI server program.

• The update resource definition file utility, CASRDTUP, now supports the DELETE command. Note that
the REMOVE option is not currently supported.

2885020 (1108004)
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Code Coverage

Back to the list

• Schema changes that affect the test coverage results generated from the tcutil utility mean that if
you propagate the results to a third-party application (for example, an XSLT processor), and rely on the
<copyFileCoverage> element, you need to alter your transformations to focus on
<sourceFileCoverage> instead. The element was renamed to more appropriately reflect its
contents, as tcutil now gives global coverage for all source files (not just copybooks).

Codeset Support

Back to the list

• Code-set mappings between ASCII and EBCDIC have been updated when Simplified Chinese is the
language in effect. ASCII table 5210 now maps to EBCDIC CCSID 836 for SBCS conversions. This
replaces the previously conversion (where ASCII table 1042 was used), which would convert the “\”
character to “$”.

3124321 (1111464)
• New single-byte character set tables for MFCODESET have been added in order to improve support for

DB2 LUW - both for off-mainframe databases and for access to z/OS DB2. A number of existing
MFCODESET mappings have also been updated. See 'Supported Country Codes' for a full listing of
ASCII/ANSI <-> EBCDIC mappings.

3111843 (1109984)

Common Communications Interface

Back to the list

• You can now configure the Micro Focus Directory Server and enterprise server region’s listeners to only
use the server's configured SSL and TLS protocols and define a priority ordered cipher suite collection.
This forces connecting clients to use the server’s preferred ordered list of cipher suites when using the
specified protocols.

2866265 (1105526)

• In some circumstances it was possible for a connection to incorrectly accept the identity of an SSL/TLS
peer and allow a connection to complete when the connection should have been denied. This occurred
due to a failure to check the peer's entire identity certificate chain. This has now been fixed. NOTE: You
might need to correct your system’s configured certificate chains that fail verification checks at secure
connection creation time.

• In some circumstances it was possible to crash the CCITCP module when it was attempting to obtain
detailed error information about a closed connection. This has been fixed.

Communications Server

Back to the list

• TN3270 conversations to Enterprise Server now correctly handle the receive (idle) timeout setting
configured for the listener. There are also two new settings for configuring TN3270 timeouts, "Printers
time out" and "Output resets timeout". See the online product documentation for more information.

3144133 (1113024)
• MFCS listeners can now be SSL-enabled without the need to have DemoCA installed.

2868627 (1105777)
• MFCS no longer initializes the Security Facility if there are no External Security Managers defined for

the region.
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Compiler

Back to the list

• Programs containing EVALUATE statements of the form: EVALUATE true | false WHEN conditional-
expression where conditional-expression included inline method invokes would give an RTS 114 error
when run as .int code, and an "Illegal .int code" error when generated. This has been fixed. Also, short
circuit evaluation is now correctly observed, such that when evaluating condition-1 AND condition-2, if
condition-2 contains an inline method invoke and condition-1 is false, then the inline method invoke is
not executed. Previously, despite being correctly evaluated, the inline method invoke in condition-2 was
being executed. Similar behavior relating to OR evaluations has also been corrected.

3138510 (1112492)
• During compilation, characters within literals that are unknown in the current locale are now less likely to

cause spurious errors. However, the correct (and safest) solution is to ensure that the locale has been
set correctly, to match the source encoding of these characters. On UNIX, this means setting LANG,
LC_CTYPE, or LC_ALL appropriately; each of these variables takes precedence over the former. On
Windows, this means setting the system locale in the 'Region and Language' section of Control Panel.

3123935 (1111148)
• The Compiler now produces an E level message - COBCH1888 Typedef is defined differently in another

external program - if different external programs have conflicting definitions of the same typedef name.
(To restore the previous behavior, where the earlier definition was ignored, use the directive
HIDEMESSAGE"1888".)

• An issue with the Compiler has been fixed so that in the RECORD VARYING clause, if the minimum
and maximum lengths are specified, the maximum length must be greater than the minimum length.

Data Tools

Back to the list

• Records with an invalid value for a conditional field will no longer result in a match for that conditional
layout.

2853226 (1103406)

Documentation

Back to the list

• You can use 'byte' or 'BYTE' as a synonym for the binary-char unsigned data type. As a result, 'byte'
and 'BYTE' are now reserved words in Managed COBOL. Use the REMOVE"BYTE" Compiler directive
to prevent an error being produced for existing programs that use the reserved word as a user-defined
word.

3147576 (1113323)
• As of version 3.0, references to types within an assembly other than mscorlib need to be explicitly

referenced. You can achieve this by using the ILREF Compiler directive. (Previously, in certain
circumstances, the Compiler would allow access to types within the System.dll assembly without the
need for an ILREF"System" directive.

3121002 (1111373)

Enterprise Server

Back to the list

• The External Security Facility (ESF) can now be configured to throttle large volumes of incoming Verify
(user authentication / signon) requests to improve resilience to denial-of-service and brute force attacks.
See "Verify Request Throttling" for more information.

3113639 (1110160)
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• The LDIF files used to create the sample configuration for Enterprise Server LDAP-based security no
longer create an empty "PHYSFILE" resource class. Changes in the JCL engine as of ES 3.0 caused
most jobs to fail when submitted to a security-enabled region using such a configuration. See the
product help for more information.

• The MLDAP ESM Module, part of the Enterprise Server External Security Facility, now supports the
Argon2 hash algorithm for creating password verifiers. See MLDAP ESM Module Custom Configuration
Information in the product help for more information. NOTE: The Argon2 hash is optional and not
enabled by default.

• The MQ pages in ESMAC are now controlled by a new security resource, MQL. This enables you to
either restrict or grant users access. 'MQL*' is a new resource that needs to be added under MFESMAC
similar to existing resources such as 'PCT*' or 'XAT*'. The following is a sample export of the LDAP
repository:

******************************
# Sample security definitions for ESMAC MQ Listeners/Writers pages

#######################
###### MQL*          ##
#######################
dn: CN=MQL*,CN=MFESMAC,CN=Enterprise Server Resources,CN=Micro 
Focus,CN=Program Data,DC=X
changetype: add
cn: MQL*
objectClass: microfocus-MFDS-Resource
microfocus-MFDS-Resource-Class: MFESMAC
microfocus-MFDS-Resource-ACE: allow:SYSADM group:alter
microfocus-MFDS-Resource-ACE: deny:*:execute
microfocus-MFDS-UID: mfuid
#description: Allow full access any ESMAC MQ Listeners/Writers Screen

******************************

3143258 (1112990)
• You can now use the ECIResponse.getReturnCode() method to obtain the return code for any errors

from Enterprise Server.

3142092 (1113248)
• Communication with the console daemon has been improved. Messages are displayed more quickly

and requests are being processed more efficiently and, as a result, times for initialization and shutdown
might be reduced.

3136867 (1112483)
• Administrators can now add, delete or modify XA resources in the Enterprise Server Administration

Web UI while a region is running.

2589624 (1085625)

• CICS Web services has been updated to include the ES_TRANCLASS_CWI environment variable,
which enables you to prioritize and limit Web requests in a TRANCLASS-enabled region. When the
ES_TRANCLASS_CWI environment variable has been set to either TCPIPSERVICE (default) or
URIMAP, a TRANCLASS-enabled region processes the elected transaction according to its priority and
associated TRANCLASS.

Note: When using CICS® Transaction Server for z/OS®, Version 3 Release 1, and IBM CICS
initiates the ATTACH transaction followed by the ALIAS transaction for a single Web request, this is
intended to enable the application of different limitations and priorities on these transactions.
Enterprise Server does not support this. Instead, a TRANCLASS-enabled region processes the
requests as a single ATTACH transaction, and uses the ALIAS transaction for security checks.

3126381 (1111349)
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• Web access to the Enterprise Server Console Log and Communications Server Log is now restricted
when the enterprise server region is secured using external security. Users will be required to provide a
valid username and password in order to view either log file.

Web access to the logs can be controlled using the standard ACL definitions under the new
Communications Server resource class, with resources Enterprise Server Console Log and
Communications Server Log. If these resources exist, users require 'read' access to be allowed to
view the logs. If the resources do not exist, the default behavior is to allow 'read' access on entry of a
valid username and password.

An example of the new resource class and resource definitions can be found in the
es_default_ldap_msuser.ldf file, which is located in the bin sub-directory of your product
directory.

Enterprise Server Auditing

Back to the list

• The maxRetryTime value in the audit configuration file now treats 0 as a no timeout time, and any
negative number as an infinite timeout.

3150566 (1113592)
• Any extra information that was added to the syslog messages will now correctly appear in the structured

data items.

Executables require relinking or recompiling

• Due to an internal change in version 4.0 of your product, you must at least relink any executable
programs compiled prior to this version, to make them compatible with the latest run-time system.
However, a full recompilation of your source code is the recommended action, to allow your executables
to benefit from the product's latest programming and performance enhancements.

Relinking an executable without recompiling means using the original object code with the cbllink
utility. Original object code is typically the binary file output (usually containing the .obj extension)
produced during the original compilation process. An application can contain one or more binary files.

File Handling

Back to the list

• In some cases the ESF LDAP Security Administration Web Interface inadvertently removed users from
groups when changing their password. This has been fixed.

3124294 (1111259)
• The ESF LDAP Security Administration Web Interface can now filter by Class and Resource name,

description, and ACL. Previously, you could only filter on Class name.

2871549 (1106119)

• For .NET applications, set XFHLOG=DEFAULT to create the XFHLOG file in the current directory;
otherwise it is created in C:\ProgramData\Micro Focus\[ED/VS]\[Release]. From release 4.0 onwards,
this variable also has an effect for native applications.

3115116 (1110323)
• Setting the configuration option ASCIISOSI=ON will adds the required SOSI characters to the relevant

EBCDIC DBCS character strings, in order for them to be displayed or written out correctly.

3113802 (1110183)
• The OPEN mode of SYSOUT files now honors the DISP specified in the JCL.

3109432 (1109745)
• OPEN I-O of a virgin ESDS file now correctly returns a file status of 35, as it does on the mainframe.
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2887724 (1108443)

• The TO parameter is now supported for TOT|TOTAL, MIN, MAX, and AVG in the TRAILER3 trailer item.

3135298 (1112194)
• The OUTFIL statement of a SORT operation now supports the NULLOFL parameter.

3110364 (1109822)
• The MFJSORT OUTFIL emulation now supports the VLTRIM parameter.

3107105 (1109820)

HCO for Microsoft SQL Server

Back to the list

• The HCOSS Manage Connections tool was incorrectly limited to using the default CCSID for mainframe
DB2 connections, causing problems when mainframe database did not use the default CCSID of 37.
This has been corrected by the addition of a text box that enables the setting of a specific CCSID value
for the connection.

3130137 (1112180)
• When using the DIALECT=MAINFRAME setting, the OpenESQL STRICTPARSE SQL compiler

directive option is now turned on by default for ODBC (DBMAN=ODBC). This ensures strict compliance
with z/OS DB2 syntax.

If your applications require the OpenESQL preprocessor to behave as it did in an earlier release,
compile using NOSTRICTPARSE.

JCL Support

Back to the list

• You can now configure MFFTP to not process trailing blank spaces for a GET command, by setting the
new control variable MFFTP_PROCESS_TRAILS_ONGET=FALSE and setting the LOCSTAT value
TRAILINGBLANKS=FALSE.

3138375 (1112486)
• ICEGENER now does not copy the RECFM from SYSUT1 to SYSUT2 if SYSUT2 RECFM is not

specified in JCL and when SYSUT1 is VSAM. It defaults to F/FB if SYSUT2 is non-VSAM, or V/VB if
SYSUT2 is VSAM.

3131268 (1111805)
• An error in identifying the IDENT in IEBGENER when the record included high values at the start of the

record has been corrected.

3109443 (1109759)
• FOR ED 2.3.2 HF7: The following changes have been made to the MF_UCC11 environment variable:

MF_UCC11=Y - when running a job with DISP=(NEW,CATLG), it will not result in job failure caused by
the data set already being cataloged. MF_UCC11=YR - when restarting a job with
DISP=(NEW,CATLG), it will not result in job failure caused by the data set already being cataloged. For
ED 3.0 HF1: The following changes have been made to the MF_UCC11 environment variable: The
default behavior of MF_UCC11=Y has changed: DISP=NEW is changed to DISP=MOD only when the
job is restarted. MF_UCC11=YA reverts to the old behavior of changing DISP=NEW to DISP=MOD
even when the job is first run.

3107409 (1109722)
• The introduction of a new environment variable, ES_OLD_DYN_PDS, has changed the resulting

behavior of dynamic PDS members when specified in a JCL DD statement. Default behavior
(ES_OLD_DYN_PDS=N) no longer creates physical files or catalogs the PDS members when specified
in a JCL DD statement. Set this variable to Y to enable the previous default behavior of creating the
physical files and cataloging PDS members when specified in a JCL DD statement.
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2845176 (1102528)
• To prevent unintended deletion of a GDG Bias, a GDG in use by one job may not be accessed by a

second job until the first job has completed.

2816745 (1101569)

Mainframe Access

Back to the list

• Calling mfmon2.exe with the following options has the given effect:

1. If you do not specify "EXTENSION" or specify "EXTENSION=" it will result in files downloaded
without an extension.

2. If you specify "EXTENSION=*" you will get an extension that matches the last part of the data set
name. For example, if the source data set is a.b.c.d then the file extension will be .d.

3. Everything else results in the extension specified. For example, "EXTENSION=txt" will result in files
downloaded with a .txt extension.

MF Server Administrator (GUI)

Back to the list

• The total number of active sessions or clients in MFDS is now limited to 2000.

Micro Focus Directory Server

Back to the list

• The mfds -g options D, O, and S have been added to the product Help.

2848627 (1102864)
• MFDS now disables and limits the scope of Web listeners on add. It also emits a warning if any

insecure Web listeners are displayed in the validate and listener tables.

PL/I Compiler

Back to the list

• Previously, storing PL/I named constants in big-endian form was incorrect and impaired some instances
of restricted expression evaluation. In ED 4.0, named constants are stored in native form when the -
bigendian compiler option is in effect.

3150931 (1113613)
• Open PL/I now supports the FLUSH statement.

3134294 (1112117)
• The %PROCESS statement now includes new compile-time options, -pporder and -options. See the

product help for more information.

3107667 (1109861)
• Pointer subtraction in 64-bit mode now works as expected.

Run-Time System

Back to the list

• The run-time system now produces a more precise error message if a shared object of the wrong bitism
is loaded.

• scan64 is no longer available. This has been superseded by the COBOL Analysis functionality in the
IDE.
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• CICS
• Commuter licenses
• Enterprise Server
• Installation
• Micro Focus Rumba
• OpenSSL

CICS

EXEC CICS VERIFY PASSWORD has a failure scenario that doesn't exist on the mainframe. It is currently
not possible to distinguish this failure from an incorrect password on the command itself via the returned
EIBRESP and EIBRESP2.

Under Enterprise Server, the following options mean that an admin LIST request to ESF is necessary to
acquire the appropriate information:

CHANGETIME
DAYSLEFT
EXPIRYTIME
INVALIDCOUNT
LASTUSETIME

If no users are signed on to CICS, then this admin request will be made as the default CICSUSER which
will be rejected.

The VERIFY PASSWORD command will return NOTAUTH 2, "The supplied password is wrong".

This is misleading because it implies that the value for PASSWORD on the command itself is incorrect.
Note that in that case, CICS returns NOTAUTH 2 as per the mainframe.

The aggregated return code from ESF to CICS for the admin request is identical in both cases and so
CICS has no way of distinguishing between these two failure scenarios. We therefore cannot return a new
EIBRESP or EIBRESP2 for this particular case.

To allow CICSUSER to make admin LIST requests, the anonymous list option needs to be enable in the
region's security manager configuration (not the Security Manager):

[Admin]
allow-list=yes

Commuter licenses

If there are a number of entries displayed in the License Administration tool, these might be either for
different products or for the same product but for different serial numbers, for example.

When a commute request is made using the license manager, that request is serviced from a pool of
licenses that could be provided by any number of Micro Focus product licenses stored on that server. The
commute request cannot target a particular RMS license by product name, serial number, or number of
cores.
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The products to which you apply the commuter licenses will be licensed correctly but the number of
licenses left in the License Administration tool might appear to be less than expected. This issue is more
likely to occur with multiple entries for the same product.

If you are using a number of different products, Micro Focus recommends that you use a different licensing
server for each product in order to help minimize the issue.

Enterprise Server

• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

Installation

• Installing this product fails if Micro Focus License Manager version 10000.2.02070 (April 2015) or older
is already installed on your machine. The setup files does not upgrade the License Manager
automatically to the latest version. You must uninstall the existing version before you start the
installation.

Micro Focus Rumba

Rumba 9.5 is not supported on Japanese Windows.

OpenSSL

The version of OpenSSL included in Enterprise Developer and Enterprise Developer 4.0 is intolerant of
expired X.509 certificates in the CA Root Certificate collection in some circumstances. Specifically, if you
configure a PEM file that contains multiple certificates as the collection of trusted CA certificates, and one
or more of the certificates in that file have expired, OpenSSL might not be able to load and use other
certificates in the file which are still valid. This can cause certificate validation errors and connection
failures for SSL and TLS connections.

To work around this, you need to remove any expired certificates from such collections. If necessary,
replaced them with any valid certificates that have the same Distinguished Name and Modulus (key). This
is a known issue with OpenSSL. Micro Focus is investigating for other possible workarounds.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Assembler Support
• CICS Support
• COBSQL
• Code Coverage
• Codeset Support
• Common Communications Interface
• Compiler
• Data Tools
• Debugging
• Dialog System
• Documentation
• EJB Generation
• Enterprise Server
• Enterprise Server for .NET
• File Handling
• IBM Language Environment for OS/390 & VM Support
• IDE
• IMS Support
• Interface Mapping Toolkit
• J2EE Connector
• Java Support for COBOL
• JCL Support
• MF Common Client
• MF Communications Server
• Micro Focus Directory Server
• Mainframe Access
• Micro Focus Batch Scheduler Integration
• Micro Focus Cryptographic Library
• Monitoring and Management
• OLE Class Library
• OO Base Class Library
• PL/I Support
• Run-Time System
• Setup Issues
• HCO for DB2 LUW
• SQL: HCO for SQL Server
• SQL: MBDT Utilities
• SQL: OpenESQL
• SQL Option for DB2
• XML Support
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Adis

Back to the list

• When running under DIALECT"RM", a DISPLAY statement using the WINDOW-CREATE clause will
create a window. Its position can be relative to the parent window or the screen. The position specified
will be the upper-left position of the first character in the window. If the window has a border specified,
the border will not change the location of the first character on the window.

3143230 (1112975)
• By default, the ZERO-FILL SCREEN SECTION clause only affects alphanumeric items when the data is

modified in an ACCEPT statement. For compatibility with ACUCOBOL-GT, Adis includes a new
selection (#3) to the option '16 Force Field to be updated if it is not altered'; it reads: 3: Alphanumeric
fields with the ZERO-FILL clause are updated even if the field is not altered.

3137641 (1112412)
• JUST (and RIGHT-JUSTIFY) now works when specified in the data item for a CONTROL clause.

3137065 (1112350)
• Internal limits that would cause a 'COBCH1990-S Internal error - Code generation of SCREEN

SECTION exceeded 65535 bytes for large SCREEN SECTION' message have been removed.

3130462 (1112572)
• Box line characters no longer disappear when using DISPLAY WINDOW BOXED and the background

contains DBCS characters.

3125337 (1111261)
• The window1 preprocessor now correctly handles underscores specified as part of a data item.

3123437 (1111084)
• When using the Window1 preprocessor to support DISPLAY WINDOW ACUCOBOL-GT syntax, Keisen

and reverse-video attributes are now supported. Note: Due to the way that the attribute system works
on a Japanese OS, to make space for Keisen attributes, background-color attributes are not supported.

3123217 (1111064)
• To emulate RM/COBOL behavior, an additional action affecting the left- and right-cursor keys within a

field has been added to ADISCTRL. Setting 25 contains a new action (value #3) that emulates the
behavior of generating an exception when trying to move beyond the left- or right-hand edge of an entry
field. However, unlike RM/COBOL, where you can control the exception generation of the left and right
cursor keys individually and specify the exception values generated, this action affects both keys, and
the values generated are fixed. They are 3 for the left arrow key, and 4 for right arrow key.

3115797 (1110548)
• The PROMPT identifier in a SCREEN SECTION now works as expected.

3115743 (1110380)

Assembler Support

Back to the list

• A problem that prevented the assembler from accepting omitted length parameters in instruction
operands has been fixed to match IBM HLASM behavior. For example, instructions of the form: PACK
AVAR(0),(,0) no longer generate assembly time invalid length errors.

3148361 (1113412)

• To enable all DC C'...' variables to be defined using ASCII instead of EBCDIC characters, the ASCII
Assembler directive has been added. To use this directive, enter: RUN MF370CHK <filename.mlc>
ASCII Note: This affects C'...' items only. For example, EBCDIC characters defined using DC X'F1' are
not affected. In addition, use of the ASCII directive could cause application logic to fail if the application
assumes character data is in EBCDIC collating sequence order.

3114383 (1110222)
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• The EIBLENG symbol has been added to the Assembler file DFHEIBLK.MAC for compatibility with the
mainframe.

CICS Support

Back to the list

• Using read-only MAP files resulted in an ABEND APCT.

3110551 (1109925)
• The OUTDESCR option for EXEC CICS SPOOLOPEN OUTPUT is now supported. The output

parameters specified using this option are available to your user printer exits.

3107410 (1109522)
• A background task issuing an EXEC CICS START transaction with data sometimes resulted in errors

when dispatching the transactions. This has been fixed.

3104918 (1109663)
• Running concurrent browse INQUIRE TERMINAL on a busy system sometimes caused an RTS 114

error in dfheserv and/or sometimes caused communication server failure. This is now fixed.

3103089 (1109282)
• EIBCALEN was re-initialized incorrectly on return from a called program.

2862990 (1104824)
• This release provides support for IBM's AUTORESETTIME option in the SIT configuration. You can

specify your preferences for AUTORESETTIME in ESMAC under Resources > by Group and by setting
a "Reset time" option in any SIT configuration. The supported options are:

• Immediate - The system detects a timezone (date) change at any time. It then changes the clock in
the region on the next transaction which is started.

• No - The system detects a timezone change at midnight and writes a notification in the console.log.
You then need to run a transaction that will issue the PERFORM RESETTIME for the time to be
changed.

• Yes - The system detects a timezone change at midnight and automatically resets the clock.

2858836 (1104325)
• When a file is defined in CICS as catalogued, Enterprise Server now displays the type as (CATLG) in

the ESMAC/ACTIVE/FCT instead of KSDS or ESDS.

2846390 (1102866)
• An enterprise server region could crash if the transaction CDBG was executed and no debugger was

attached.

2828665 (1100470)
• The QUEUE disposition for an extra-partition is now honored on open.

2638481 (1088593)

• casrdo52 no longer crashes intermittently.

2841426 (1102352)
• The T-Type page in ESMAC has been fixed.

2832495 (1100861)
• The maximum value for ES_ESMAC_DISP_MAX_OVERRIDE has been changed to 99999.

2832069 (1100820)
• When browsing the contents of a file in the ESMAC catalog page, the back arrow button, "<", now

navigates to the previous page instead of to an empty list of files.

2822494 (1099670)
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• The TS/TD warm/cold start flag state in SIT was only checked for TRANCLASS. It is now always
checked.

2676393 (1092162)
• Memory validation on entry or exit of programs can now be set dynamically from the Control page in

ESMAC.

• The CFLE /K option now works correctly.

2860360 (1104438)
• The refresh rate for displaying the search records has been updated and the search algorithm is now

faster.

2856608 (1104800)

• Any special characters for Transaction used in DEFINE TRANSACTION are now imported correctly and
will be displayed in ESMAC.

2886545 (1108211)
• When creating a new SYSC resource in ESMAC, Enterprise Server now performs a validation and

returns an error if you specify any invalid parameters.

2881865 (1107538)
• When defining a TDQUEUE, a value of 0 for RECORDSIZE is now accepted.

2807605 (1097659)

COBSQL

Back to the list

• A problem that caused COBSQL to mishandle EBCDIC conversion when the program was called more
than once has been fixed.

3145943 (1113226)
• A problem that caused incorrect indentations in generated code when using the KEEPCOMP directive

has been fixed.

3144736 (1113124)
• A problem with COBSQL handling of spaces between the colon and the host variable name has been

fixed.

3144632 (1113283)
• A problem with COBSQL incorrectly handling the AMODE directive has been fixed.

3144632 (1113257)
• COBSQL now correctly handles host variables with the same name that are defined in different groups.

3139017 (1112553)
• KEEPCOMP will now check SQLCODE for FETCH statements before performing a byte order swap on

COMP data items.

3138321 (1112476)
• A problem with COBSQL correctly handling replaced lines greater than 72 characters in length has

been fixed.

3127369 (1111465)
• COBSQL failed to recognize declared host variables that were identified using a two-part name. This

has been fixed.

3127102 (1111417)
• A problem that caused the COBSQL preprocessor to incorrectly handle the WORKING-STORAGE

SECTION statement has been fixed.

3124957 (1111232)
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• An occasional problem with COBSQL reinitialization that caused the second background parse to fail
has been fixed.

3124170 (1111154)
• The COBSQL preprocessor was not handling COPY... REPLACING... statements correctly, causing the

Debugger to display incorrect information. This has been fixed.

3123903 (1111140)
• A problem that caused COBSQL to fail to parse the PROCEDURE DIVISION statement correctly when

part of the statement was in a copybook has been fixed.

3122593 (1111019)
• A problem that caused the COBSQL preprocessor to fail to generate HSF trace data When either the

EBCDIC or KEEPCOMP option was specified has been fixed.

3120860 (1110883)
• A problem that prevented COBSQL from processing more than 150 lines of similar source code in a

single source file has been fixed.

3112520 (1110134)
• A problem that caused the COBSQL preprocessor to incorrectly process child items when either the

KEEPCOMP or EBCDIC options were specified has been fixed.

3110932 (1110772)
• A problem that prevented the COBSQL preprocessor to correctly process data groups when the

KEEPCOMP directive was specified has been fixed.

3110932 (1110575)
• A problem that caused COBSQL to fail to recognize all data items correctly when the host variable was

a group item has been fixed.

3110932 (1110650)
• A problem that prevented COBSQL from correctly recognizing the parents of some data items when the

KEEPCOMP directive was specified has been fixed.

3110932 (1110495)

Code Coverage

Back to the list

• Correct results are now displayed when you generate a report on a program that is part of a shared
object.

3108051 (1109995)
• TCUtil will now run correctly without KSH installed.

Codeset Support

Back to the list

• The current Shift-JIS EBCDIC to ASCII support under MFCODESET=81,930,939, and 9122 is based
on the Japanese International Standard (JIS) X 0208 1978 revision. New conversion tables have been
added based on the JIS X 0208 1990 revision - the tables have been taken from IBM's Conversion
Tables CCSID 300 - 941. To use these new conversions instead of the default ones, set
MFCODESET_DBCS=941.

3143604 (1112980)

Common Communications Interface

Back to the list
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• An intermittent failure to establish a TCP connection with various components (including CCITCP,
COBOL service deployment, and JCL job submission) was caused by the EADDRINUSE error. This has
been fixed.

3123202 (1111222)

Compiler

Back to the list

• The 'cobol' command line tool now produces the correct type of output when a 'dll' file is specified using
lowercase; for example: cobol b.cbl,b.dll; Previously, specifying 'DLL' worked as expected, but 'dll'
produced an executable file.

3147888 (1113355)
• An error when adding a literal or unsigned-display-item to an unsigned-display-item, where the receiving

item contains SPACES or LOW-VALUES, and the SIGN-FIXUP directive is in effect, has been fixed.

3133590 (1112121)
• For .gnt compiled file types on Intel x86 32-bit only, when call-convention 2 (called program clears stack

- also known as Windows stdcall) and call-convention 8 (litlink) are both in effect, call-convention 8 is
suppressed. This behavior can be turned off by setting the GNTLITLINKSTD directive. This directive
has no effect on other platforms.

3132861 (1111990)
• A bug moving a numeric literal to a national alphanumeric variable has been fixed.

3130652 (1111946)
• A fatal error at generate time has been fixed.

3122718 (1111075)
• A bug whilst stepping through the EVALUATE statement in the debugger has been fixed.
• (390 generated code only) An issue that occurred when variable length items used in an IF statement

followed by a MOVE statement has been fixed.
• An issue where compiling some large programs to 64-bit generated code on Windows led to an

EXCEPTION_STACK_OVERFLOW has been fixed.
• In 64-bit generated code, a call of the form: call "prog" using by value -1 would not sign-extend the by

value parameter correctly. Thus, if the receiving program was of the form: linkage section. 01 p0 pic
s9(18) comp-5. procedure division using by value p0. then p0 would receive an incorrect value.

• The presence of a hyphen character in a copybook name is no longer flagged under a mainframe
dialect if located in the portion truncated by the TRUNCCOPY directive.

3150945 (1113635)
• Certain ACUCOBOL-GT format ACCEPT statements, such as ACCEPT ... FROM SYSTEM-INFO and

ACCEPT ... FROM INPUT STATUS, no longer cause unexpected run-time errors. (They continue to be
flagged as unsupported, and now have no run-time effect.)

3145581 (1113165)
• In the IDE, when switching between different programs that use the CONSTANT Compiler directive,

background parses now complete cleanly, as expected, and do not crash.

3144957 (1113156)
• OO inheritance involving data with non-ASCII characters now compiles and executes as expected.

3143962 (1113013)
• An OPEN EXTEND statement referencing a sequential file with a LINAGE clause no longer produces a

spurious warning message.

3141789 (1112810)
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• Integer-1 for the LINE clause or the COLUMN clause (of the SCREEN section) must be an unsigned
integer, greater than zero and less than 256. However, this value is also restricted by the physical limits
of the screen. If you enter a value greater than 256, you receive a COBCH0027 error.

3140501 (1112691)
• An INITIALIZE statement whose target is subscripted and contains one or more object references now

produces correct object code.

3138563 (1112509)
• An ILREF directive that contains non-ascii characters is now processed as expected.

3137227 (1112362)
• When the run-time system detects that external files have inconsistent declarations, it now reports the

internal file-name of the file in question, and where possible, reports the inconsistency.

3133860 (1112467)
• Compiler output associated with the XREF option now shows correctly for NATIONAL types.

3131449 (1111836)
• A COPY REPLACING statement that has parenthesis in the replacement text, and is compiled with the

COBSQL preprocessor with CP enabled, now compiles as expected.

3131355 (1111897)
• A bug has been fixed in programs that contain both XML PARSE and XML GENERATE statements, and

the last such statement is XML GENERATE.

3130455 (1111752)
• Passing an intrinsic function as a parameter in a standard INVOKE statement, where the target method

interface defines the parameter as BY REFERENCE, now compiles and executes correctly, as long as
the INVOKE correctly specifies 'BY CONTENT' and is compiled with the REPOSITORY"CHECKING
ON" Compiler option.

3129593 (1111645)
• Support has been added for a new directive DISPSIGN, which emulates the IBM mainframe option of

the same name. It controls the display output of included signs for numeric items, and only affects
output when an IBM mainframe dialect has been specified.

3127646 (1111445)
• Implicitly declared assign names in a program compiled with the REENTRANT"2" directive are now

processed as expected.

3126919 (1111383)
• The COBOL Copy View now correctly shows copy contents for remote projects that use the CP

preprocessor and a mainframe dialect.

3125362 (1111326)
• The FDCLEAR directive now works as expected for a WRITE statement with an INVALID KEY clause

that contains statements referencing other files.

3124343 (1111171)
• The 'window1' preprocessor now respects the setting of the MFCOMMENT directive.

3123999 (1111149)
• A tooltip query of an item defined in a method and whose parent shares a name with another unrelated

item in a different method now works as expected.

3123598 (1111113)
• An INITIALIZE statement with FASTINIT enabled (which is the default) should not affect table contents if

no portion of the table is explicitly assigned a value by the statement (strictly speaking the content is
documented as undefined).

3123417 (1111098)
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• A program compiled with FOLDCALLNAME"LOWER", which contains a CALL to a nested program,
now executes as expected.

3123260 (1111085)
• A DISPLAY of a signed usage display numeric field that contains non-numeric data now better emulates

mainframe behaviour when under a mainframe dialect.

3121234 (1111025)
• A national data item with an associated 88 level that uses the THRU phrase and references

alphanumeric literals (rather than national literals), is now processed as expected, for better mainframe
emulation (that is, the literals are treated implicitly as national literals).

3119944 (1110838)
• A program with an EXEC CICS statement that references the address of a linkage item no longer

receives a spurious warning message about the item not having addressability.

3119004 (1110648)
• A 'Determine Directives' request for an Eclipse remote project now functions as expected, and does not

crash.

3119003 (1111177)
• Inherited object storage from the OO class library now gives correct results.

3117353 (1110502)
• The 'headers' preprocessor now functions as expected during a background parse.

3115971 (1110871)
• Under the Enterprise COBOL dialect, the limit for the size of a record in a sort file description has been

increased to 32767; this is to reflect the limit on the mainframe.

3115808 (1110443)
• The SSRANGE Compiler directive no longer causes an erroneous out-of-bounds error for a reference-

modified variable length group specified as a target item and where the occurs depending on field is
located within the group.

3113495 (1110154)
• When using Quick Browse, the various counts around comment lines no longer grows between

background parses.

3112271 (1110046)
• A non-ANSI abbreviated condition that compiled in older products now similarly compiles and executes

(for backward compatibility) in this product.

3109284 (1109737)
• Using the PROFILE directive with a nested program no longer causes a Compiler error.

3108308 (1109633)
• Compiling a program containing ENTRY statements with an SQL ECM no longer produces a spurious

warning about code being unreachable.

2991017 (1108767)
• The MOVE-LEN-CHECK directive now verifies MOVE statements with reference modified operands that

have literal lengths.

2988987 (1110162)
• Compilation using the CP preprocessor, where one or more source files are located on the mainframe,

now works as expected.

2886117 (1109429)
• A DISPLAY of a large amount of data in a program compiled with the OUTDD directive now produces a

SYSOUT file with all data included without truncation.

2885153 (1108021)
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• A DISPLAY statement with a very large number of operands now compiles as expected.

2882748 (1107771)
• The correct source location is now reported for the FLAGSTD format error message associated with

code being in the wrong area of source.

2880234 (1107348)
• A SCREEN section declaration with FOREGROUND-COLOUR and HIGHLIGHT clauses now compiles

as expected.

2873489 (1106450)
• Siemens BS2000 COBOL support now extends to the BASED clause and the BYTE-LENGTH intrinsic

function.

2855428 (1103760)
• A new toggle option has been added to the OOCTRL directive, to allow the choice of whether .ins

and .cls inheritance files have directory location comments. OOCTRL(-L) now turns the comments off.

2853073 (1103758)
• An ON EXCEPTION clause on a CHAIN or CALL PROGRAM statement now works as expected, and

does not cause bad stepping behavior while debugging.

2852872 (1110615)
• A SORT or MERGE statement where the maximum size of an input record is larger than the sort

description, or the maximum size of an output record is smaller than the sort description, is now flagged
with an E-level Compiler message.

2826647 (1100193)
• Using an intrinsic function as a parameter to an inline method invoke now works as expected.
• An inline method now works as a parameter to an inline method. Using the workaround of making the

parameter an arithmetic expression (for example, by adding "+ 0") is no longer required.
• The Compiler directive ACUSYNC now appears in the SETTINGS output, as expected.

• The use of abbreviated, combined conditional expressions involving object types, and with more than
one AND/OR, no longer causes spurious errors.

3139986 (1112733)
• In Managed code, when a SET or COMPUTE statement has a target of type 'decimal' and a source that

is an arithmetic expression involving COBOL numeric items, incorrect results are no longer produced.

3139348 (1112587)
• A NEXT SENTENCE statement in a TRY/CATCH block will now generate valid code. However, NEXT

SENTENCE is not advisable within a TRY/CATCH block as its effect is to transfer control to the
statement following the next statement terminated by a period ('.'), which will be outside the scope of the
TRY/CATCH block. In most cases where older COBOL used NEXT SENTENCE, this can be substituted
with the CONTINUE statement.

3137297 (1112427)
• A change in behaviour in Microsoft .NET version 4.7 means that a previously valid use of the IL cpblk

instruction now causes an access violation exception. The Micro Focus Compiler has been altered so
that it no longer generates the cpblk instruction if the length is known to be 0.

3134521 (1112127)
• In managed code, the CHECKDIV"ACOS" directive now functions correctly when one of the operands in

a DIVIDE/REMAINDER statement is subscripted.

3131075 (1111787)
• When a class program is compiled with SQL directives, and when that class includes a constructor

starting with an explicit call to the super constructor (or to another constructor in the same class), then
incorrect code was generated, resulting in a null reference exception. This is now fixed.

3119858 (1110755)
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• The SHARING WITH ALL phrase in the SELECT statement now works as expected in managed code.

3115943 (1110393)
• The RECORD-POSITION construct, provided as part of the ACUCOBOL-GT compatibility support, now

behaves as it does in ACUCOBOL-GT COBOL. Previously, if used on an item within a group, then the
offset produced could be less than expected, which was due to an optimization in the Compiler that
eliminated unused data.

3115356 (1110346)
• Invoking a method that has a return type with attributes no longer leads to incorrect analysis of the

optional parameters, or spurious compilation errors.

3115237 (1110370)
• The directives ILSMARTANNOTATE and ILSMARTTRIM have been added. ILSMARTANNOTATE - adds

attributes to the items generated by ILSMARTLINKAGE, based on their data type, which can be used to
identify the size or range of the item in COBOL. (.NET COBOL only) ILSMARTTRIM - trims any trailing
spaces from a string item returned by the get property associated with an alphanumeric item processed
by ILSMARTLINKAGE Full details can be found in the product documentation.

2885821 (1111970)
• ILSMARTLINKAGE now produces a COBCH0842 error if two items in a smart linkage record differ only

by the presence or absence of a '-' character. If such an error is encountered, it will be necessary to
modify one of these names so that the two are different once '-' characters are removed. Previously, this
scenario was producing a system error during the ilasm phase.

2851761 (1103271)

Data Tools

Back to the list

• The /d parameter of the DFSTRCL command line utility is no longer case sensitive.

2989512 (1108654)

• Applying a filter to a data file after selecting a field no longer causes the editor to crash.

3139552 (1112637)
• Large structure files can now be loaded within the editor.

3122802 (1111101)
• When performing a filter more than once, the filter no longer encounters a 9/41 corrupt indexed file, and

the correct navigation buttons are enabled. Additionally, the filter now shows the correct number of
filtered records.

2883777 (1110293)
• The Data File editor now enables you to export filtered results to a new data file: option Search>Export

Results when a filter is in effect.

2878521 (1107103)

• DFCONV now shows its version number, rather than "TEST", when used from the command line.

3114824 (1110281)
• Classic Data File Tools now supports IDXFORMAT(12). You can create files of this format, and use the

Data File Convert tool and DFCONV command line utility (including .pro files) to convert to and from
this format.

3113772 (1110180)

Debugging

Back to the list
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• Conditional breakpoints are now hit when evaluating conditions involving decimal values.

3126090 (1111323)
• The IDE no longer crashes when debugging is stopped after an OO exception has occurred.

3117381 (1110513)
• Conditional breakpoints now work in OO classes.

3117357 (1110507)
• Examining Object COBOL instances in the debugger now works for 64-bit applications.

3106962 (1109917)

Dialog System

Back to the list

• ActiveX controls can now be accessed when using visual styles enabled by the MFVSSW environment
variable on Windows 7.

3126684 (1111746)
• The behavior of the Dialog System painter when positioning and resizing dialog boxes now matches the

behavior in Net Express.

3123843 (1111132)
• DSOPTIONM is now supported in Visual COBOL and Enterprise Developer.

3121434 (1110923)

• Trying to run a user program that uses Dialog System Character mode no longer fails with error "198
Load failure".

3125166 (1111342)

Documentation

Back to the list

• The documentation now states that the ILSMARTLINKAGE directive is only for use with procedural
COBOL programs, not COBOL classes.

3147500 (1113420)
• The product help now clarifies that cblcored.exe requires write permission to the current user’s

HKEY_CURRENT_USER key in the Windows registry. This ensures that any changes to the Core
Dump settings made with the utility will persist.

3142772 (1112972)
• The IMS Tracing Flags topic has been updated to accurately reflect the options available in Enterprise

Server.

3142342 (1113320)
• An important distinction has been made in the documentation, in that the content of nonnumeric literals,

comment lines, comment entries and data can include any of the 'printable' characters available in the
current character encoding scheme. See the 'Character Set' topic of the Language Reference Manual
for more information.

3140851 (1112720)
• The 'Standard File Header' topic now states that the definition is not applicable to certain indexed file

formats. The definition of the node sizes, as specified in the 'Index File - File Header' topic, has also
been clarified so that it applies to all applicable MF index file formats.

3140352 (1112840)
• The ACCEPT statement documentation now contains the possible values codes/definitions returned for

EXCEPTION STATUS.
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3138691 (1112556)
• The documentation now documents the difference between MF COBOL and RM/COBOL when

inspecting the EXCEPTION STATUS in an ACCEPT statement.

3138691 (1112555)
• Documentation for the SPZERO Compiler directive now directs you towards the preferred replacement,

SIGN-FIXUP.

3135675 (1112227)
• The order in which the File Handler searches for the File Handling configuration file has been correctly

documented for UNIX and Windows platforms.

3132391 (1111933)
• The use of the INTLEVEL Compiler directive has been clarified in the documentation; that is, it is an

internal directive, not intended for customer use.

3129661 (1112191)
• If mnemonic-name is associated with ENVIRONMENT-NAME in an ACCEPT or DISPLAY statement, its

value must not exceed 255 bytes.

3126506 (1111354)
• The "Tutorial: Creating and Accessing WCF COBOL Services" now includes the correct instructions.

3125963 (1111310)
• A restriction has been documented for the X"B0" Function 2 library routine, where console applications

cannot distinguish between the left and right Shift key presses.

3125717 (1111316)
• The sample code listed within the documentation topics 'Customizing an STC scheduler address space

JCL' and 'Customizing a user server address space JCL' has been corrected to include missing syntax.

3124411 (1113586)
• The "Tutorial: Creating a Native COBOL Application" in the product help has been updated. It no longer

mentions a Reference folder in the solution as native COBOL applications projects do not use the
Reference folder.

3120440 (1110804)
• The documented example for OO switches has been updated to remove an obsolete switch.

3117356 (1110506)
• A new syntax rule (#9) has been added to the CALL statement topic in the Language Reference

Manual, stating the restriction of passing a floating point item BY VALUE in native COBOL.

3115091 (1110326)
• The documentation for the BELL directive has been corrected to state that it is checked during the

syntax checking phase, and not at the generate phase.

3110088 (1109799)
• In the documentation, the steps required to customize ASCII\EBCDIC character set conversion have

been clarified.

3108884 (1109682)
• More information has been added for file and project level problem error markers. See Maximum

Number of Problem Error Markers for more information.

2881233 (1107671)
• An error has been corrected in the description of the "Go To Procedure Division" option in the "Making

the Most Out of The COBOL Editor" topic.

2877216 (1106910)
• Documentation for 'COBRT181 Invalid parameter error' has been expanded to include a possible cause

and solution for the error.
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2876095 (1106782)
• The instructions on how to install Fileshare as a Windows service have been clarified - see

'Walkthrough - Fileshare as a Service' in the product docs.

2876085 (1106746)
• The product help now clarifies that adding the Micro Focus Runtime (Interop RuntimeServices)

assembly adds the MicroFocus.COBOL.RuntimeServices reference to a Visual Studio project.

2850791 (1103124)
• The Sharing Database Connections Between Java and COBOL topic has been updated with an

example showing object sharing with other languages both when Java opens the connection and when
COBOL opens the connection.

2674454 (1091949)
• The ANSI92ENTRY topic has been updated to include OpenESQL behavior in corfomance with the

ANSI-92 standard.

2596163 (1086171)
• The SQLCODE Values topic has been updated to reflect the most current information available.

2593799 (1085947)
• The CALL-RECOVERY documentation topic has been amended for clarity. The syntax and behavior is

unchanged. When a CICS transaction has installed an ABEND handler at a given link level, if an
ABEND occurs lower down the call chain where non-CICS programs have been called between the
owner of the handler and the abending program, the CALL-RECOVERY directive ensures that control is
passed directly back to the higher level without executing application code after the call(s) in the
intervening programs. Parameters <integer> - Must be one of:

1. Makes the program check the current call recovery state every time control is returned to it following
a call. If there is a controlled exit in force the program performs a GOBACK, that is, passes control
back up the COBOL call chain rather than continuing with the next statement

2. As for 1, but also catches exceptions on CALL dataname statements and sets the call recovery state
before performing a GOBACK to pass control back up the COBOL call chain.

Note: You should use CALL-RECOVERY when compiling a mixture of CICS and non-CICS programs for
running in Mainframe Subsystem Support. Only the non-CICS modules need be compiled with the
appropriate directive. When compiling only CICS programs, CALL-RECOVERY is not required.

• The error message description for COBCH1558 has been expanded to include the possible scenario of
when a difference in bitism (between Java version and compilation mode) has caused the error.

• The COBCH1006 error message text has been corrected to encompass the fact that different dialects
have different limits for the length of a COBOL word.

• The documentation has been corrected to state that the LINKLIB directive is not required by the cobol
command. (LINKLIB was an old directive that should no longer be used.)

• The Codecomp Utility documentation now states that you can only create customized tables for single-
byte character sets.

• An incorrect reference to SYSREC has been removed from the example in the topic "SQLTP2 Utility -
Executing Dynamic SQL Statements".

3145877 (1113167)
• When using the MVSSPLHK spool housekeeping process to override the retain period of a class; for

example: CLASS A 003 Y this refers to the output dataset class, and not the job class.

3138584 (1112576)
• The instructions on running the SPOOL conversion tool (splconv) have been updated with

recommendations for setting the MFSYSCAT_ERRS variable. This is because there are a number of
errors generated whilst running the conversion that can be safely ignored, and setting this variable to a
sufficient value will allow the conversion to complete successfully.

3124350 (1111280)
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• Documentation for MFJSABCODE has been added to the Sort environment variables.

• The product help now includes details about the CESL CICS supplied transaction. CDEQ, CZTD and
CZTS are only internal and not directly executable.

3153520 (1113840)
• When running the dfconv command line utility, the (optional) -d option must be the first parameter

specified in order to have an effect.

3135598 (1112570)
• The product help about "Datetime Literals in SQL Statements" now correctly states that to enable the

functionality, you need to code any of the specified SQL comments into your DB2 mainframe
application, positioned before a literal declaration.

3133502 (1112053)
• Where appropriate, the SYNCSORT and DFSORT documentation now links directly to the topic that

explains the various field types in use.

3123796 (1111143)
• Error message BMSCH1099W has been documented.

3122477 (1111005)
• Details for error BMSCH1083W have been added to the documentation.

3122476 (1111004)
• The topic that lists the Compiler directives restricted in Managed COBOL has been brought up to date.

3120358 (1110789)
• To enable Language Environment (LE) support for all applications (other than JCL) running in

Enterprise Server, set the environment variable ES_LE370_SUPPORT=Y

3118312 (1110678)
• Documentation now includes JCL event information for the 'event-job-stmt-info' and 'event-uxit-changed-

job-name' events.

2990395 (1108725)
• Information on the TCLS Entity has been added to the product documentation. See Resource Classes

for ESMAC and Operator Command Security for more information.

2913474 (1108497)
• The documentation now references the es_default_ldap.ldf file, which contains a working example for

using the DATASET resource class.

2860914 (1104513)
• The documentation has been updated to explain how best to configure CICS for use with WebSphere

MQ.

2817494 (1099421)

EJB Generation

Back to the list

• A problem that caused EJB client generation to fail when processing OCCURS arrays has been fixed.

3131411 (1111877)

Enterprise Server

Back to the list

• Starting the MFDS process with the -r option will now disable the Web administration UI. If using a
browser to connect to the MFDS TCP network address, you now receive an HTTP 403 response.
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• A missing form name in some Enterprise Server Administration pages could result in a JavaScript error.

• The default options under ESMAC > Resources now depend on the Region options. If JES is installed,
the new default resource to show under Resources is JES. If IMS is installed, and JES is not installed,
then IMS is the default. If MQ is installed, and both JES and IMS are not installed, then MQ is the
default. If iFS is installed, and each of JES, IMS, and MQ are not installed, then iFS is the default.
Otherwise, the default resource is Services.

2871166 (1106098)

• An issue using single sign-on between MFDS and ESMAC has now been fixed.

3106232 (1109779)
• The Enterprise Server External Security Facility (ESF) has improved redundant / failover support for

Security Managers. See "Security Configuration Custom Configuration Information" in the product help
for more information.

2990790 (1109080)
• The Enterprise Server External Security Facility's MLDAP ESM Module can now generate an audit

event describing the "effective rule" that determined the decision (allow / deny / permissions set) for an
Auth or XAuth request. The effective rule is the security rule that was used to make the decision. See
“MLDAP ESM Module Custom Configuration Information” in the product documentation for more
information.

2887945 (1110096)
• Enterprise Server Security trace message 2003, emitted when a SAFROUTE(Auth) request is made

with the "API trace" flag enabled and access to the resource is denied, no longer truncates long
resource names. Long names are abbreviated but still provide the prefix and suffix of the name.

2885856 (1108682)
• Enterprise Server's External Security Facility, when using LDAP-based security, has an "Update"

mechanism that can be used to notify MFDS and running Enterprise Server regions of changes to
security information. This now works correctly for changes to group membership, for example, when a
user is removed from a group.

2873024 (1106452)
• Depending on the sequence of login, users with long usernames that contained spaces and that had

usernames similar to other users could login and find that they are treated as if they do not have the
correct user permissions. This has now been fixed.

• In Enterprise Server, when using LDAP-based security, if a user belonged to a group with an LDAP
wildcard character (such as "*") in its name, and there were nested groups defined, and the use-all-
groups mode was enabled, groups that contain other groups could be incorrectly added to the user's
group set. This has been fixed.

• mfds and casstart will now run successfully on machines with locale names with the @modifier part,
such as fr_FR.iso885915@euro.

2868439 (1105641)

• A CICS JSON RESTful provider that was invoked with an HTTP GET and subsequently executed an
INVOKE SERVICE would fail to map its response data to JSON.

3151018 (1113677)
• Previously, a CICS Web Service requester application would receive INVREQ 13 on an INVOKE

SERVICE if it had been initiated via HTTP with a method other than POST.

3151018 (1113623)
• Extended ECI LUW context is now maintained.

3148577 (1113418)
• Using the dump command from an MQ listener resulted in an AB/BA lock.

3146317 (1113217)
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• In 64-bit environments, ECI requests that do not use ES_ECI_SOCKET to identify or locate the target
region used to fail.

3143232 (1112962)
• Receiving an IMSConnect request before CASTMC had fully started up could result in a trap in casgate.

3142402 (1112977)
• A request made with valid credentials no longer fails after an initial request that returned an error ECI-

ERR-SECURITY-ERROR.

3142092 (1113220)
• The Data File Editor now supports DSNs that contain the '£' and '#' characters.

3140182 (1112661)
• You no longer receive a PGMIDERR error on the second invocation of a CICS program when using a

symbolic link (and the shared object name does not end in .so) and FORCE PROGRAM PHASEIN is
off.

3139816 (1112624)
• The casstop /w command no longer creates a ccierr.log when a region terminates during the /w delay.

3135994 (1112257)
• Previously, when creating a new DFHDRDAT, the provided users had an invalid phrase setup which

resulted in sign-on errors.

3135433 (1112238)
• An "MVSJOBNO not found" error sometimes occurred when canceling a JCL job from the command

line. This has been fixed.

3134787 (1112325)
• CICS Web services now provide basic JSON boolean support.

3134676 (1112143)
• You no longer receive a JES000002E error in the ESMAC Admin SEP when submitting JCL after

viewing a previous job details.

3129388 (1112985)
• When a job that performs an EXCI LINK without the SYNCONRETURN option was submitted twice in

succession, the second job did not run successfully.

3129348 (1111596)
• An issue that could cause a memory corruption in CWS when application tracing was not ON has been

fixed.

3127485 (1111431)
• previously, HSF records for tasks that executed prior to a switch of the active file could be written to the

newly active file. This has been fixed so that records are written to the file that was active at the time the
task ran.

3125864 (1111322)
• CICS now accepts JSONTRANSFRM and XMLTRANSFORM resource names of up to their maximum

lengths - 16 and 32 bytes, respectively. The previous limit was 15 bytes.

3123595 (1111110)
• An issue with DFHJSON where JSON data would not be written to a container has been resolved.

3121607 (1110917)
• The casutl command line utility supports a new option, /x, which enables you to switch the active trace,

dump and/or hsf files. For more details, see your product's documentation.

3120728 (1110848)
• When recycling SEPs in a busy JES system, jobs that have not run yet are now managed correctly.

3120670 (1111235)
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• In a busy system, if JCL jobs timed out or were cancelled, the local trace entries could sometimes
corrupt the shared memory causing the region to become unresponsive.

3116835 (1110501)
• You no longer receive an RTS 200 error message when a duplicate START of a transaction is presented

for execution at a target terminal which is busy. The duplicate AIDs are now discarded as under
mainframe CICS(tm).

3114982 (1110686)
• Mapping structures to containers in DFHJSON when there are consecutive multiple empty elements

now works as expected.

3114815 (1110285)
• If the result length from a call to CBL_CCSID_CONVERT was smaller than the original buffer length,

garbage was written at the end of the buffer. This was because the length used was the original length
and not the length returned from the call.

3114365 (1110223)
• You no longer receive an error message when a single-byte EBCDIC character gets converted to a

double-byte UTF-8 character in CICS WEB SERVICES.

3112898 (1110070)
• A FREEMAIN of a shared pointer which had been populated in a SEP other than the one attempting the

free would provoke a trap.

3112416 (1110196)
• When either a CPMT NEW COPY is issued or FORCE PHASEIN is enabled on the SIT, MAPs are now

reloaded from the disk and the memory version will not be used.

3105813 (1109891)
• The CICS internal reader under Tranclass could sometimes hang and stop processing work.

2988428 (1110144)
• System folders that have a backslash at the end of the name are now supported in region

configurations. Previously, a region would fail to start in such scenarios.

2886956 (1108250)
• The following issues with HSF have been resolved:

• HSF records could be generated with a date prior to the date when the task actually started. This
could affect low-activity SEPs.

• If a task ran over midnight then its response time would always be 1 centisecond regardless of how
long it ran for.

• If a SEP was in the middle of either a CICS command, an EXEC SQL statement or a DLI call at
midnight, then the API, SQL or IMS field respectively would contain a high and incorrect value.

2870896 (1110045)
• If there was an error when trying to start cobdebugremote, the port was not retrieved.

2864798 (1105495)
• When defining a GDG model, the path is now grayed out.

2855374 (1103840)
• It is now possible to use environment variables in MQ Listeners queue names.

2842137 (1102027)
• If a casout -g command to retrieve relative DD for a job was issued and the resulting file had a size of 0,

the file was left open which resulted in a leak of handle.

2814439 (1098608)
• Previously, Enterprise Server returned a mismatch error if you tried to add a new JES initiator from

MFDS when the region was already started.
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2812102 (1098408)
• An issue causing the BlueZone terminal emulator to disconnect has been resolved.

2807210 (1098676)
• Requests are now aborted if the ECI luw token is invalid.
• An issue with EXEC CICS SIGNON using PASSWORD in Enterprise Developer 3.0 could require an

application to have the PASSWORD variable used on the SIGNON command defined as PIC X(100)
rather than PIC X(8).

(1110862)
• The "Use all groups" option for a secure enterprise server instance now enables the Data File Editor to

authenticate a user against all of the groups for a particular user.
• Using casout with the /v option (to list initiators, printers and mprs) could cause incorrect HSF records to

be generated.
• An issue where some HSF records for JCL steps could have incorrect response times and condition

codes has been resolved.
• It is now possible to edit the dataset name entry in ESMAC if an incorrect name was submitted when

adding the dataset.

• A problem that caused a non-facility (file) DCT trigger to fail to reset the "triggered application active"
flag even when the queue had not been taken to QZERO has been fixed.

3147018 (1113307)
• Documentation regarding support of the STATUS option on EXEC CICS INQUIRE PROGRAM and

EXEC CICS SET PROGRAM has been corrected.

3145947 (1113176)
• EXEC CICS INQUIRE now correctly retrieves TSQs with names greater than eight characters.

3145414 (1113131)
• A problem with SOAP message validation that caused an error on messages containing an ampersand

(&) character has been fixed.

3142837 (1112955)
• An issue with WRITEQ TS REWRITE using an ITEM number greater that 32,767 with TRANCLASS

enabled now fails as expected. Enterprise Server no longer targets the wrong item returning an
EIBRESP of NORMAL.

3142092 (631187)
• A problem with EXEC CICS VERIFY PASSWORD always authorizing against the default CICSUSER,

sometimes resulting in a failure when the default CICS user was different than the current CICS user,
has been fixed.

3141790 (1112971)
• An incorrect response was being sent to the client when the default application handler was not used.

3141757 (1112838)
• An issue with DFHFUNCTION prevented CICS Web services from returning a 16-byte space-filled field.

The DFHFUNCTION container now returns the value padded with spaces in a 16-byte field.

3141477 (1112779)
• During a CICS DELAY, internal requests for file operations were not processed, sometimes causing

open/close file commands to hang. This is now fixed.

3132496 (1111945)
• A problem with recovering a CICS region after terminating MFCS when CSKL was running has been

fixed.

3130515 (1111788)
• Using CICS FREE CONVID with TRANCLASS no longer results in a SEP to be recycled.

3129235 (1111650)
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• In CICS regions in which all SEPs were busy, duplicate DTP requests for the same session were
chained, causing consecutive requests to hang. This has been fixed.

3126761 (1111397)
• A problem that caused HSF records for transactions initiated via APPC to contain an incorrect response

time has been fixed to provide the correct response time. In addition, PCT counts for these transactions
have been updated.

3122337 (1111091)
• A problem with the JSON CICS Web Services 'bottom up' demonstration application that appeared in

version 3.0, Patch Update 1 has been fixed.

3122046 (1110957)
• The default transaction class 'DFHCTL00' is now returned when an INQUIRE transaction specifies the

option TRANCLASS and no TRANCLASS value was specified when the resource was installed.

3121827 (1110974)
• A problem that caused an ISC connection to occasionally automatically reconnect after it was released

from the active SysC page has been resolved.

3120128 (1110769)
• Calling a PL/I program from ECI no longer results in a trap.

3119928 (1110753)
• A problem that sometimes caused an ASRA abend after an EXEC CICS LOAD PROGRAM for PLI has

been fixed.

3119006 (1110649)
• An incorrect MAPFAIL error was returned when a conversational transaction was executed with Force

Wait on Send in the SIT option. This has been fixed.

3113520 (1110251)
• Making an EXCI call from batch to CICS which uses CICS Web Services no longer results in an error

RTS 173 on mF_ES_initialiseStack. Previously, casstack was being unloaded and is now built as a
system program.

3112236 (1110184)
• A problem that sometimes caused EXEC CICS LOAD PROGRAM for a PLI program with

ES_FPPI_LOAD_SUPPORT enabled to fail has been fixed.

3112121 (1109994)
• CICS Temporary Storage Queue expiry is now honored for systems that run with TRANCLASS enabled.
• CICS APIs against type LOCAL Temporary Storage Queues now return values for LENGTH and

NUMITEMS.

• Imported hexadecimal transactions are not truncated anymore.

3153155 (1113813)
• Fixed an issue with the admin seps terminating abnormally when a USER (who is not associated with a

group in ESM) tries to logon to ESMAC.

3152197 (1113814)
• Access to the XAT resources in ESMAC (casrdo65) is now controlled by the user's security settings for

the 'XAT*' resource under MFESMAC. The user will require "Update" access to the GRP resource in
order to see the XAT Delete button.

3143258 (1112991)
• TCPIPSERVICE resources are no longer erased when the URIMAP resource is set to PIPELINE. In

addition, ESMAC now accepts blank WEBSERVICE fields.

3141235 (1112752)
• The deletion of a PDS member in a secure region now use the correct classes.
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3140443 (1112709)
• Sometimes the STOP button for connected clients in ESMAC was not displayed when security was on.

This has now been fixed.

3139885 (1112724)
• Date and time filter values are now retained when the jobs are filtered to user requirements in ESMAC.

3138516 (1112498)
• The Reply button for a waiting from console JOB in ESMAC is now enabled or disabled depending on

user authority.

3137426 (1112397)
• The environment variables ES_DISABLE_DFLTUSR_SIGNON/

ES_ESM_DISABLE_DFLTUSER_ESMAC are now correctly honored in secure regions.

3133646 (1112061)
• When specifying the ES_MAX_CATALOG_LINES environment variable, one line fewer were displayed

in the ESMAC catalog view. This has been fixed.

3129034 (1111563)
• The 9/041 error no longer occurs when accessing catalog after running a job that accesses the proclib.

3122584 (1111066)
• An issue in the date and time filters in the ESMAC spool display page has now been fixed.

3122475 (1111003)
• The Job page now displays in Shift JIS encoding if the operating system encoding is determined to be

Shift JIS.

3115107 (1110311)
• The SIT 'New' button is no longer greyed out when the ESMAC user has the appropriate permission.

2913474 (1108809)
• If the Data File Editor was used to retrieve the DCB information for a data file hosted by Enterprise

Server and the catalog did not contain a physical filename, an RTS 114 error would be encountered.
This has now been fixed.

• A user setting ES_CICS_SINGLE=Y enabled them to signon to more than one terminal at a time. This
has now been fixed.

2913254 (1109223)

• The PostgreSQL switch module now loads correctly in 64-bit mode.

3149380 (1113516)
• A problem recovering from errors where SQL Server unilaterally terminates an XA transaction has been

resolved.

3145058 (1113133)
• User Impersonation now works as expected when using an ODBC switch module in batch mode.

3140100 (1112655)
• The ESMSSQL switch module no longer returns an RTS153 error if USERP=T is set and the user does

not exist.

3140097 (1112649)
• The Oracle switch module no longer fails with an RTS153 error when being enabled after an initial

connection error.

3129198 (1111608)

• Auditing using syslog now reconnects correctly after the syslog server restarts.

3135191 (1112186)
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• Auditing modules are now loadable on all supported platforms.

3124417 (1111183)
• Syslog messages can now be configured to use TLS as the transport protocol.

Enterprise Server for .NET

Back to the list

• A problem that caused SEEListener service shutdown failure when one or more MQ channels were
defined has been fixed.

3132854 (1111975)
• When running a non-facility task such as an MQ-triggered CICS transaction, an ArgumentNullException

occurred if no PCT was defined for the transaction. To assist in resolving this issue, Enterprise Server
for .NET has been updated to output an error message indicating the cause of the task failure to the
screen and to the Windows event log.

3125627 (1111298)
• Calling MQCONN from a CICS transaction running under Enterprise Server for .NET returned an

incorrect HCONN. This has been fixed.

3108726 (1109686)
• A DISPLAY by a CICS transaction running under Enterprise Server for .NET caused the IIS application

in which it was running to recycle. This has been corrected in that DISPLAYs are now routed to the
SYSOUT dataset allocated by the JES partner region (SSTM).

3108724 (1109785)
• When a CICS transaction performed multiple non-ACCUM TN3270 output operations (such as EXEC

CICS SEND) within a single unit of work, data could occasionally be delivered to the client out-of-order.
• The managed code LE assembly MicroFocus.SEE.LE370 did not include the CEE3SRP API, which has

now been added.

• A problem with the MMC UI catalog file viewer that caused the function performed by clicking the "next
100 records" button to read file records in the incorrect sequence has been fixed.

3149777 (1113544)
• When Rollback Disposition was set to either 'No Scratch and Empty' or 'Scratch and Empty,' all GDG

datasets would be deleted from the catalog when the GDG was edited. This has been fixed.

3136912 (1112499)
• GDG Definition rollback disposition values have been modified to clarify when 'No Empty' is selected.

3136910 (1112380)
• A problem that caused a GEG index file to lose the value for the Key Length property when it was edited

has been fixed. Note: The Key Length property on a GEG index represents the number of generations.

3136908 (1112371)
• The region startup file now includes a new option, "preserve spool records", which is enabled by default.

Setting this to false will enable spool record cleanup which runs in the background when the region is
started, and deletes all of the spool record files. The following restrictions apply: - Spool record cleanup
does not work with self-hosted region start, only with WAS hosted. The region must be started using
MMC, or using the -was flag for the seestart utility. - Spool record cleanup also does not work if the
region's dataset location has been changed between region starts.

3136740 (1112357)
• In some circumstances, properties defined in a region startup file were being ignored. This problem was

more likely to manifest when the region startup file was stored in the cross-region database, but could
potentially happen in other situations. This has been resolved.

3134701 (1112302)
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• When running JCL that performed a sort, a 9/220 "duplicate sort" error sometimes occurred. This has
been fixed.

3134360 (1112214)
• When using a database-hosted catalog under Enterprise Server for .NET, SQL exceptions that occurred

during delete record operations incorrectly resulted in jobs terminating with a zero condition code
instead of abending. This has been fixed.

3132447 (1111943)
• A problem that caused a user database connection to leak each time a CICS transaction or JCL job

step used EXEC SQL has been fixed.

3127539 (1111450)
• A problem with Event Manager that caused a slowdown in event output performance when one or more

durable pub/sub subscribers became disconnected has been fixed.

3123470 (1111097)
• A problem that caused job submissions to fail when no or very few job numbers were available for

allocation has been fixed.

3123090 (1111055)
• A problem during the shutdown process of an Enterprise Server for .NET region that was caused by a

step that initiated a failed attempt to contact an unreachable remote event monitor and that resulted in
an error has been fixed by updating the shutdown process to omit this step.

3122079 (1110966)
• The MMC UI Catalog view now outputs a message in the status area when the configured maximum

number of catalog records to be retrieved has been reached.

3122044 (1110955)
• Event publishing used by the Micro Focus Batch Scheduler (MFBI) has been made significantly more

robust in that it now recovers more gracefully from a number of error conditions, and better handles
ServerTooBusyException for WCF interactions among Enterprise Server for .NET components.

3121878 (1110928)
• A problem that caused event subscribers to exhibit an intermittent NullReferenceException in the

GetRawEvent and similar methods has been fixed.

3121335 (1110921)
• A problem that caused a semi-colon to be appended to the PATH environment each time a job was

submitted or run caused environment space to become exhausted over time. This has been fixed.

3121328 (1110867)
• A limitation on the public CasSub.Submit() method that prevented it from returning only job numbers

less than 65536 has been removed.

3121225 (1110868)
• The seesys command-line utility has been enhanced to list all registered event monitors and to delete or

unregister "in doubt" event monitors.

3121066 (1110965)
• Performance for the submission and execution of jobs has been enhanced. For this enhancement to

take effect, you must stop and then cold start your enterprise server region.

3120585 (1110815)
• Publish and subscribe support has been optimized to reduce the amount of region database I/O that

occurs when publishing events, thus providing potentially significant improvements to the performance
of a running system.

3120372 (1110850)
• A problem that caused the failure of jobs to cancel properly when the user application was performing a

long-running SQL statement has been fixed.
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3119070 (1111266)
• A problem with the MMC UI file viewer that caused a significant delay in completion when thousands of

selected lines had been copied to the clipboard has been fixed.

3118194 (1110585)
• A problem that kept initiators active and thus unavailable for subsequent job dispatches when a large

volume of concurrent jobs were being submitted and executed has been fixed. Important: To apply this
fix for stored procedures, you must stop and then cold start all enterprise server regions to enable
database installation.

3117273 (1110518)
• A problem that caused job failure with a user-verification error when a job was submitted using the

internal reader from a job running under a non-default user account, and when security was enabled,
has been fixed.

3115575 (1110372)
• Under a heavily loaded Enterprise Server for .NET JES region, spool record updates sometimes failed

and had to be retried, resulting in events being output to the Windows event log. This has been fixed.

3114883 (1110291)
• A problem that caused the MMC UI Console view to sometimes needlessly write AdmXcpt9044 errors

to the Windows event log has been fixed.

3114877 (1110289)
• Region properties can now be specified in region start-up files.

3114757 (1110279)
• A problem that sometimes caused the SEPs in a heavily loaded JES region to stop processing new job

submission requests has been fixed.

3114653 (1110288)
• A problem that caused SEP pool recovery to fail for warm-started Enterprise Server for .NET regions

has been fixed.

3113895 (1110192)
• Using casout/seeout to query a job's status in an Enterprise Server for .NET system had a performance

impact on running jobs.

3112929 (1110085)
• A dispose() method has been added to the Enterprise Server for .NET CasSub and CasOut public

classes to enable you to force the underlying connection to the listener to be disconnected when a
request needs to be aborted.

3112277 (1110128)
• A problem that prevented the JES region from accepting client requests has been fixed.

3112277 (1110151)
• The name of the properties file used to configure a region was not displayed in the console during a

cold-start. This has been fixed.

3112192 (1110004)
• The MMC UI Spool view has been enhanced to allow the paging of displayed job spool records instead

of fetching all job records. This provides a significant improvement in performance when there are tens
of thousands of jobs associated with a region.

3112057 (1109988)
• The Output pane of the Spool view in the Enterprise Server for .NET MMC UI has been enhanced to

display job step information for regions configured to use JCL.

3112053 (1110260)
• A problem with running or submitting many jobs in parallel caused intermittent SQL lock victim errors.

This has been fixed.
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3109621 (1109763)
• A problem that caused job submissions using the public CasSub class to fail if communications to the

listener process was stopped and re-started between job submissions. This has been fixed.

3109532 (1109940)
• The CasOut and CasSub public classes used to retrieve JCL job output and to submit JCL, and the

seeeout command-line utility now support an optional timeout.

3109529 (1109878)
• The Microsoft Management Console (MMC) Data Store view did not correctly display folder names with

embedded spaces, preventing navigation into these folders. This has been fixed.
• When running jobs under Enterprise Server for .NET with regions using a configurable recycling

strategy, a NullReferenceExceptions error occurred. This has been fixed.
• A problem that prevented the Start-SEERegion PowerShell cmdlet to honor the -warmstart option has

been fixed.
• When using a JES region that includes spaces in the path specification for database-hosted catalog/

data, I/O errors occurred when submitting JCL. This has been fixed.

• The MMC UI Spool View has been enhanced to reduce the amount of CPU consumed when refreshing
large numbers of jobs.

3118855 (1110808)

File Handling

Back to the list

• Users, Groups, and Classes can once again be searched based on substring matches, rather than full
exact matches.

3127314 (1111414)
• Password Expiry and Account Expiry dates are now correctly displayed in the ESF LDAP Security

Administration Web Interface when specifying times in 24 hour format.

2883964 (1107911)
• The Users in the "Members" list for Groups and Groups in the "Group Membership" list for Users are no

longer incorrectly filtered by the filter on the respective "Users" and "Groups" main tabs.

2871547 (1106121)
• The ESF LDAP Security Administration Web Interface no longer incorrectly displays a blank Users/

Groups list when changing tabs.

2863056 (1104795)

• The REPRO of a cluster that contains an alternate index no longer performs the copy using the
alternate index. It uses the primary index instead.

3136566 (1112386)
• When running under a mainframe emulation, if the INDD record length does not match the cataloged

length for SYSIN when performing an ACCEPT statement, and that results in a partial record being
read, that record is now returned (as it does on the mainframe).

3120786 (1111421)
• 9/41 additional statuses 2, 4, 5 are no longer printed to the log without an associated log entry for the

actual 9/41 error.

3115318 (1110341)
• Setting RUNITLOCKDETECT=OFF no longer causes an unhandled exception when a file is opened

multiple times in managed code.

2885757 (1108212)
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• File Handler settings supplied by the extfh.cfg configuration file are now captured in CTF tracing of the
File Handler.

2849599 (1102983)

• If, in a single process, Fileshare is called with both FCD2 and FCD3, the filename sent to Fileshare no
longer becomes corrupted.

3131960 (1112168)
• The reading of keys no longer fails when the indexed file that was open prior to the current file was not

explicitly closed.

3129038 (1111565)
• The EXTFH option RETRYOPEN has no effect when set in the Fileshare Server configuration file.

3106992 (1111699)
• An SPLJNO filename will no longer become corrupted when being accessed simultaneously through a

Fileshare server currently under load.

3106992 (1112094)

• iFileshare no longer hangs during a stop run operation if files being used in the program are accessed
through different iFileshares.

3142333 (1112939)

• MFJ_INPUTDS_ERROR=N is now honored for DFSORT and ICETOOL emulation.

3151761 (1113797)
• ICETOOLS DISPLAY operators now display correct formats.

3132530 (1112032)
• SORT CODE EQ NUM is now working as expected with EBCDIC records.

3113121 (1110145)
• For dataset names that contain an environment variable that holds the name of a Fileshare server,

MFJSORT will no longer give a 9/004 file status.

3109801 (1109898)
• MFJSORT will now correctly close all opened files in the case where each file in the output group is

handled differently. Thus, SYNCSORT behavior is now the same between versions 2.3 and 2.3.2

3106550 (1109627)
• Sorting concatenated LSEQ or NULLFILE/DUMMY files no longer produces an error.

3106223 (1109452)
• During a SORT operation, SEQNUM now correctly starts at sequence number 1.

3106111 (1109444)
• MFJSORT now correctly treats LSEQ files as CHARSET ASCII regardless of CHARSET setting.

IBM Language Environment for OS/390 & VM Support

Back to the list

• A problem was encountered with assigning heap storage after it had previously been cleared using the
CEEGTST and CEECRHP Language Environment routines used in 64-bit mode (COBMODE=64). This
has now been fixed.

3104480 (1110751)
• Calling the Language Environment modules CEE3GRP and CEEMRCE no longer results in an RTS

173 error. See "Enable Language Environment (LE) Support' in your product help for details on how to
enable LE support.
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IDE

Back to the list

• Visual Studio no longer becomes unresponsive when you hover certain data items in the editor. An
issue with handling if sources files that contain a high number of data items that share the same name
has been resolved.

3151264 (1113641)
• Visual Studio no longer hangs when IntelliSense parses large conditional expressions that contain

multiple AND and OR operators that are bracketed. For example: IF (AAA equal BBB) OR (BBB equal
AAA) OR (AAA equal BBB) OR (BBB equal AAA) OR.

3139764 (1112650)
• Visual Studio now starts correctly when Micro Focus Rumba 9.5 Service Pack 1 installed on the same

machine.

3139206 (1112662)
• A .dep file becoming corrupted no longer results in performance issues in Visual Studio.

3138956 (1112588)
• The Compile menu item is now disabled if the Find editor window is in focus.

3137573 (1112573)
• Performing the Clean command on a project now only cleans the .idy files which that project generated

or has information about. It will not delete other .idy files that might be found in the same locations .

3137375 (1112846)
• Using the editor in over-type mode (when the Insert key is active) was incorrectly causing word

wrapping.

3136781 (1112335)
• The editor now colors correctly any variables referenced inside the String and Unstring statements.

3133687 (1112102)
• Visual Studio now sets the correct INT directive when working with UNC paths.

3132695 (1112036)
• Ambiguous data items are now colored correctly in EXEC SQL blocks.

3128123 (1112088)
• The Clear Credentials menu option in Server Explorer is now enabled for remote enterprise servers.

3127998 (1111474)
• The Net Express Import Wizard no longer ignores user-specified copybook paths.

3127338 (1111425)
• Double-clicking the text in the COBOL margins in the Visual Studio editor now selects the specific word.

Previously, it would select the the entire contents of the margin.

3125347 (1111281)
• The Go To Definition command now works correctly in native object-oriented programs and

distinguishes between static and instance data items.

3124150 (1111155)
• Double-clicking on a quoted method name that contains hyphens in the editor now selects both the

word and the quotation marks.

3123638 (1111123)
• Source files that use the PREXML preprocessor no longer get locked after parsing.

3123413 (1111115)
• It is now possible to view read-only application.config files in Visual Studio.
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3122397 (1111007)
• QuickInfo ToolTip now show the correct content for ambiguous data items in native classes.

3120787 (1110840)
• A new option is now available inside Visual Studio in Tools > Options > Micro Focus > Standalone

Editing > General. It enables you to specify whether only the current file is saved when compiling a
standalone program.

3118218 (1110587)
• Executing the Find All References command on a project which requires more memory than available

on your machine now fails more gracefully, without crashing the IDE.

3117355 (1110505)
• An issue where the MicroFocus.COBOL.QualityTools package could fail to load on non-English locale

installations of Windows has been fixed.

3117354 (1110503)
• The debug information is now displayed correctly for qualified variable names in SQL statements.

3114079 (1110336)
• Visual Studio no longer emits a message 'Value of data item shown as "5-S User-name FIELD-NAME

not unique"' when you are adding variables to the Watch window while debugging. The IDE now
correctly resolves the fully qualified names of group items and adds the respective variables to the
Watch window.

3114062 (1110334)
• The tooltip style checkbox 'Show OCCURS or reference modification value' now uses the correct value

when set from TOOLS > Options > Debugging > Micro Focus COBOL.

3114052 (1110353)
• Watchpoints now work correctly when attaching the Visual Studio debugger to a running process.

3111005 (1109942)
• In Visual Studio 2017 and later, it is now possible to query the properties of managed objects in the

Immediate and the Watch windows during debugging.

2878336 (1107091)
• When you double-click a quoted method name in the editor to make a selection, it now includes the

quotes.

2862321 (1104724)
• In Visual Studio 2017 and later, it is now possible to add properties of managed objects to the Watch

window during debugging.

2697588 (1094159)
• In Visual Studio 2017 and later, it is now possible to expand IEnumerable object types while

debugging .NET COBOL code.

2613665 (1087919)
• Building a project which you renamed could fail.
• After a successful project build when there was an .idy file in the output folder, if you later deleted

that .idy file and rebuilt the project, the .idy file would reappear in the folder.
• When expanding copybooks within a COBOL program, files which you do not have write access to

(such as 'system' copybooks supplied with the COBOL product) are now read-only within the editor.
This depends on the permissions which you start Visual Studio with. If you start the IDE with
Administrator privileges, then you will have permissions to write to the system copybooks, and they do
not appear as read-only in the editor.

• The Project Details now shows the correct file type for files with non-standard file extensions which you
add to COBOL projects.
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• If you open a source file that is not part of a COBOL project, such as a stand-alone COBOL source file,
or a source file within a folder that you have opened, the file is now shown in the Project Details window.
If you close the file, it will disappear from the Project Details window.

• The spelling of the PL/I macro argument -inc_after has been corrected to -incafter.
• Cancelling a Find All References command when the search scope is set on the entire solution now

works as expected. Previously, the cancellation only occurred after all projects have been parsed.
• The performance of the Find All References command executed after a build when the search scope is

the entire solution has been improved.
• Managed projects that contain resources are no longer rebuilt on each build or run in Visual Studio

2017.
• The time to load projects containing many thousands of items has been improved.

IMS Support

Back to the list

• A problem that sometimes caused a read-only IMS batch program (PROCOPT=GO) to encounter an
incorrect status code of AI has been fixed.

3145385 (1113189)
• An invalid GD or GE status code was issued when inserting a physical child of a logical parent using a

logical view when the virtual logical child was defined with multiple sequence fields. This has been fixed.

3143889 (1113032)
• An "AO" status code was sometimes erroneously returned when updating a logical parent database

through a logical view. This has been fixed.

3140617 (1112764)
• An erroneous DJ status was returned to a REPL call when a DLI call was issued to another PCB

between the GH* call and the REPL call. This has been fixed.

3140173 (1112684)
• An erroneous DA status was returned to a REPL call when the GET-HOLD call preceding it was only

partially successful. This has been fixed.

3138482 (1112600)
• A GNP call following a GE (not found) status sometimes returned incorrect PCB key feedback

information. This has been fixed.

3137412 (1112558)
• The mfims imsdbu ADD command incorrectly required the REPLACE/NOREPLACE directive to have a

value. This has been fixed.

3125697 (1111332)
• The IMS Recovery Utility has been updated to enable you to specify a point in time at which to recover

a database. See your product documentation for details.

3117798 (1110547)
• When using an IMS DB Catalog file (IMSDBCAT.DAT) in support of Remote IMS or USERDB exit, a

program that issued a restart (XRST) or checkpoint (CHKP) call resulted in unpredictable behavior. This
has been fixed.

3108346 (1109655)
• An x'0900' was incorrectly returned in the AIB return code for an EBCDIC application using the AIBTDLI

interface. While this did not affect the success of the call, return code has been corrected.

3106210 (1109548)

• The ESMAC > SPOOL page now displays the JOB START and JOB END times.

2886742 (1108293)
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• A problem with MFS generation not properly generating MID output for TN3270 devices has been fixed.
All TN3270 devices always default to Input/Ouput and always generate a MID and DIF in addition to
MOD and DOF unless explicitly defined otherwise by the DIV macro in the MFS source.

3151923 (1113702)
• A problem with MFS generation that incorrectly caused multiple input segments for OPT=2 type MFS to

be shortened has been resolved.

3148697 (1113538)
• A problem that caused messages sent to the terminal by IMS to display on a blank screen instead of in

the SYSMSG field defined in the MFS source has been fixed.

3147331 (1113351)
• A problem that caused print output to be formatted incorrectly when consecutive output fields had no

space between them. This has been fixed. This fix requires that you regenerate MFS source.

3143588 (1113101)
• A problem that caused an incorrect cursor position in the I/O area of an IMS program has been fixed.

This fix applies to both ASCII and EBCDIC, and is not affected by MFS data case conversion. MFS
regeneration is not required.

3141057 (1112928)
• A problem that caused abends when formatting printer data has been fixed.

3138921 (1112865)
• A problem that sometimes caused MFS formats designated as output only to incorrectly generate an

input format has been corrected to now generate only the appropriate MOD/DOF output control blocks.

3135140 (1112240)
• Trailing spaces are no longer be removed from the input message when OPT=2 is specified in the MFS

source.

3131882 (1112075)
• The input field (MFLD) that was mapped from a nonexistent device field (DFLD) has a default literal

assigned to it. Previously, this literal was ignored. The literal value (in this particular case, the tran code)
is now moved to the input buffer even if the device field does not exist.

3131869 (1111904)
• When multiple MODs referenced a different subset of DPAGES from the same device, MFS generation

output was incorrect, causing IMS to hang at run time. This has been fixed; however, to correct the
problem, you must regenerate the MFS after installing this update.

3123517 (1111315)
• When FILL=NONE is specified on the DPAGE macro in the MFS source, the output screen fields will be

padded with whatever character is specified in the MOD. Otherwise, the MOD fill character is ignored.
Regenerate your MFS in order for the appropriate flags to be updated.

3118064 (1110571)
• Light pen support has been added to IMS MFS.

2870473 (1105952)

• A PURG call to a modifiable alternate PCB issued without first establishing a destination returned a DLI
status of A3. This has been changed to return a DLI status of spaces provided there is no message to
insert.

3129240 (1111770)
• A problem that caused a parsing error on parameters provided for EXEC DLI has been fixed.

3128279 (1111493)
• A problem that caused the EXEC DLI preprocessor to incorrectly parse inner parentheses and issue an

error message has been fixed.
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3115734 (1110379)
• A problem that caused a "Not Protect" condition to return a 0000 status code in the auth I/O area

feedback has been fixed to correctly return a 0004 code.

3110324 (1109823)

• A problem that caused an IMS TM transaction to wait indefinitely for a response from an external
resource manager has been fixed to terminate the transaction when its process time limit is exceeded.

3145988 (1113188)
• When users switched activity between two or more LUs (terminals), a new signon to a previously used

LU failed to return the signon initial screen produced by the <transaction-id>. The failure was specifically
associated with the following configuration combination: ES_CICS_SINGLE=y ES_DFS3650=TRX
ES_IMS_FORCE_SIGNON=Y ES_IMS_GOTO_CICS_ON_SIGNOFF=Y ES_TRX3650=<transaction-
id> This failure has been resolved.

3144089 (1113054)
• A problem that caused a loop in CASTMC when an XA resource manager was enabled has been fixed.

3141157 (1112874)
• Asynchronous/unsolicited output to an IMS Connect client is now supported.

3140384 (1112781)
• MQ-IMS Bridge output messages can now be routed to a reply queue based on LTERM, as configured

using the new OTMA destination-descriptors environment variable, ES_IMS_OTMA_DEST.

3139850 (1112808)
• Sporadic memory corruption in CASTMC no longer occurs.

3134730 (1112708)
• A problem that caused an RTS114 error when a second IMS sign-on from a user already associated

with a different logical terminal has been fixed.

3128579 (1112160)
• A problem that incorrectly caused an DFS2082 system message to be returned to an IMS Connect

client by an IMS application has been fixed.

3109139 (1110050)

Interface Mapping Toolkit

Back to the list

• A problem that caused memory leaks in JSON-based Web Services has been fixed.

3109465 (1109773)

J2EE Connector

Back to the list

• You no longer receive Java heap errors when a resource adapter is passing large amounts of data.

3120684 (1110892)
• JSP generation works correctly when there are OCCURS fields.

2869932 (1105858)

Java Support for COBOL

Back to the list

• The Javademos Readme files have been updated with new instructions.
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JCL Support

Back to the list

• A file locked error (9/068) on SPLJOB, occurring after deleting a printed dataset, has been corrected.

3151227 (1113747)
• If you are using wildcards to identify the datasets on which to perform a function of the public catalog

interface program (mvscatpb), and the dataset name criteria is 44 characters or more, you should use
the * wildcard as the first character of the dataset name.

3149739 (1113570)
• A failure to submit JCL jobs from a CICS program via the internal reader has been corrected.

3148986 (1113522)
• MFJAMS (IDCAMS) does not rename the members of a dynamic PDS when the cataloged PO dataset

is renamed.

3146461 (1113337)
• Using MFFTP, when you GET a FB file, the file retrieved is now padded with low-values to the length of

(or a multiple of) the LRECL.

3141536 (1112787)
• If a job fails and leaves active GDG biases, the next job that requires use of the GDG will reset the bias

numbering to include the active biases from the failed job.

3141379 (1112768)
• The use of the environment variable ES_CATLG_DISABLE_ADDITIONAL_QUAL has been replaced by

a check box named Disable Additional Qualifiers, which is located on the ESMAC Data Catalog page.
The functionality provided by the new check box is equivalent to that of the variable: when checked, the
use of additional qualifiers when displaying data sets in the catalog is disabled; for example, when
checked, a filter of A.B would only return a data set of A.B. When unchecked, a filter of A.B would return
all data sets starting A.B (as if A.B** had been entered).

3138176 (1112494)
• Test comparisons now works as expected for nested procs with duplicate step-names.

3136138 (1112290)
• MFJSORT now handles concatenated variable length LSEQ input files correctly, and does not generate

a 9/139 error.

3135888 (1112365)
• A problem with Job Ready and Job Submitted messages not appearing in SSTM-enabled regions has

been corrected.

3135320 (1112207)
• GDG generation count is now correct when the GDG is defined with SCRATCH and EMPTY options

and generations during DD processing.

3134244 (1112355)
• Setting the environment variable ES_CATLG_DISABLE_ADDITIONAL_QUAL=Y no longer impacts the

results of an IDCAMS LISTCAT LVL step.

3133201 (1112011)
• A change in the tracing of the IDANIP01 module, introduced in ED 3.0 PU3, and was producing an RTS

114 error when tracing SSTM jobs, has been corrected.

3133184 (1112035)
• The environment variable ES_CATLG_DISABLE_ADDITIONAL_QUAL now no longer affects results

from the MVSCATIO if calls were made from utilities such as IDCAMS.

3132978 (1112009)
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• Multiple quoted parameters are now permitted on the MFFTP input line.

3132764 (1111982)
• MFFTP now allows the use of input datasets with an LRECL greater than 80.

3132360 (1111960)
• MFFTP no longer leaves a lock on a dataset when it executes a GET command.

3131732 (1111951)
• An RTS 114 error reported when deleting the last batch job from the spool has been corrected.

3131671 (1111884)
• MFFTP now works as expected when large files are transmitted.

3129865 (1111862)
• The processing of IP format in OUTPUT statements has been corrected so that it does not cause JCL

parser errors.

3129388 (1111604)
• A problem transferring LSEQ format files in MFFTP has been corrected.

3129323 (1111606)
• When environment variable ES_PROG_PATH is set to 'Y', a program's load path can be viewed in the

JESYSMSG and also in SYSLOG.

3123641 (1111130)
• The job record now holds the correct numbers of HELD, OUT, and COMPLETED spool datasets after

the spool conversion utility (SPLCONV) has been run.

3123298 (1111314)
• A problem with initialization of a procedure in the first job that a SEP runs has been corrected.

3123002 (1111050)
• Calling MFJZLOG from a CICS or IMS region is supported if the region is SSTM-enabled. The API is

not supported to run under ES for .NET.

3122665 (1111137)
• When a dataset rename operation fails, the physical file is no longer renamed.

3117963 (1110582)
• MFJPTPCH now works correctly when the input dynamic PDS path contains an environment variable.

3113225 (1110193)
• The GDG-CURR-BIAS value in the CATALOG is now correctly updated when the current GDG bias is

deleted.

3112986 (1110127)
• The JOBRC parameter on a JCL JOB statement is now parsed and ignored.

3107427 (1109575)
• The COND CODE from an MFFTP step that errors calling sftp is now set to at least 4. Should MFFTP

detect ‘ERROR’ status messages in the output from the mfsftp script, it will set the return code to 8.

3106682 (1109971)
• Referback on DCB now resolves correctly when only the PROCSTEPNAME is mentioned without the

STEPNAME.

3105486 (1109350)
• A problem with the catalog listing returning extraneous PO entries when a wildcard had been specified

has been corrected.

2883777 (1110201)
• There is now a marked improvement in the time taken to filter the catalog list when asking for just one

record and ES_CATLG_DISABLE_ADDITIONAL_QUAL=Y is set.
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2883777 (1110148)
• MVSCATPB no longer incorrectly applies values from previous records when updating a catalog record.

2881470 (1107585)
• The error reporting in MFJAMS has been improved so that it reports the file status of the file, along with

return code of 16, when a DELETE fails.

2875995 (1106881)
• A number of enhancements have been made to the behavior of user catalogs to make them more

resilient. See 'Support for Multiple Catalogs' in the documentation for full details.

2868958 (1105727)
• ES_ALLOC_OVERRIDE now honours PO and PDSM rules specified in the configuration file.

2866945 (1105413)
• When using the MFFTP utility, trailing blank spaces in generated 'lcd' commands are now removed.
• The ES_ESMAC_DISP_MAX_OVERRIDE environment variable now has an effect when files are

accessed directly from the job list page.
• A problem where MFUSERCAT_BASE_LOC was not prepended to any catalog file that did not specify

a path has been corrected.
• A 'Binary Flow Mismatch' error when using casout to kill a non-existent job has been corrected.
• A failure to grant access to a dataset with a PHYSFILE rule that did not end in with a wildcard has been

corrected.
• The incorrect application of JOB KEEP entries in the spool housekeeping utility has been corrected.
• 4-digit condition codes that include a cond-code type are now returned correctly in the public spool

interface (mvscaspb).
• Flushing a job no longer results in spool records for a different job being deleted.

• ESMAC now displays the correct number of lines that the user has selected in the spool view.

3100998 (1108889)
• If "Local ES Security Enabled" is enabled in ESMAC, Enterprise Server now verifies whether the user

has sufficient permissions to submit jobs.

2837220 (1101415)

MF Common Client

Back to the list

• The Micro Focus Common Client now allows the comma character in HTTP URLs. This affects COBOL
web services clients, CICS Web Interface, and CICS Web Services.

3127463 (1111430)
• MFCC will now always allow the use of a CCI.INI file without crashing.

3123531 (1111144)

MF Communications Server

Back to the list

• Enterprise Server and the Micro Focus Common Client now support opening more than 256 SSL-
enabled endpoints simultaneously. Also, a resource leak in the MFCS process for HTTPS connections
made with CICS Web Interface or CICS Web Services has been fixed.

3137166 (1112477)
• A situation where some terminal emulators were unable to connect to an enterprise server region has

been fixed.

3135166 (1112195)
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• The maximum size of an HTTP header value allowed for a CICS Web Interface or CICS Web Services
server can now be configured. Include an [HTTP] section in the configuration information on the Edit
Communications Process page, and use the option 'maximum header value length=<num-of-bytes>'. If
not specified, the default number of bytes is 1024.

3127781 (1111480)
• A bug that caused some clients to crash MFCS when submitting 3-character trancodes has been fixed.

3121264 (1111026)
• Enterprise Server now correctly handles chunked HTTP message bodies. The CRLF sequences, which

appear after each chunk, are now removed when the chunked body is consolidated.

3100279 (1109784)
• The Enterprise Server Communications Process (MFCS) can now restrict access to listeners by client

address. See "Conversation Filtering" in the product Help for more information.

2887418 (1108517)
• Enterprise Server's backward compatibility with older versions of MFDS has been restored.

MF Directory Server

Back to the list

• Automatic corrections are now made to invalid Enterprise Server listener ISC configurations when they
are loaded or imported.

3136730 (1112328)
• Regions exported using MFDS now include the IMS query name if present.

3130077 (1111684)
• A missing product HTML file could cause the Enterprise Server Administration HTML GUI to revert to

using English text rather than the configured language. This is now fixed.

3118363 (1110595)
• A memory leak in the MFDS process which could cause an intermittent crash has been fixed.

2886846 (1108593)
• The "mfCASIMSMFSNullChar" and "mfCASIMSTMMQColdStart" IMS region attribute values are now

imported correctly from a previously generated XML export from the Micro Focus Directory Server.

2879665 (1107226)
• The "IMS Configuration Directory" configuration value has been deprecated and has been removed

from the Enterprise Server Administration Web UI for Enterprise Server instance properties.
• For additional security, any start, stop or not-responding region scripts region will only be executed if the

Micro Focus Directory Server restricted administration is enabled.
• You could get an RTS115 error in MFDS on AIX when performing certain actions such as browsing the

properties of an ESM.
• When executing Enterprise Server in a Docker container, you need to set the

MFDS_EXTERNAL_ADDR environment variable to a resolvable external address string (a hostname
rather than an IP address) in the Docker environment. This is to enable client browsers to resolve
ESMAC and other URLs in Enterprise Server Administration. The value of this variable will replace the
internal container address in the URL.

• The Enterprise Server Administration Web UI "Directories" menu item and functionality has been
deprecated and is no longer available.

• If MFCS control channel is configured to use SSL, MFDS must have an environment variable "MFDS_
$SERVERNAME_CAROOT" defined, which points to the full file path of the CA root certificate used to
sign the control channel's certificates.

Mainframe Access

Back to the list
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• MFDAS now correctly imports binary data as binary when MFDAS_CODE_PAGE was set to a DBCS
page. Previously, it was imported as ASCII.

3150576 (1113612)
• MFDAS import commands using file as *.* or type as AUTO now download correctly.

3145965 (1113223)
• MFA DBCS calls now use an appropriate SBCS default.

3144286 (1113100)
• Eclipse no longer crashes when calling commands after an MFA rename.

3143624 (1113181)
• Using the MFDAS DIR END FILTER command no longer causes a crash.

3136640 (1112468)
• When using a codepage other than IBM-037 syncmon2 could fail to sync PDS members that contained

the section symbol in their name. This has now been fixed.

3130696 (1111807)
• MFDAS KSDS-FIXED import no longer ignores fixed files.

3129963 (1111679)
• An issue with the MFDAS /FIXEDVSAM parameter has been resolved.

3129963 (1111680)
• The MFA_SERVER_PARMS environment variable now changes the Mfdeamon query when user

credentials are not known.

3127797 (1111962)
• MFDAS STATUS jobname filter now works as expected.
• Specifying invalid SSL details when configuring AWM in Eclipse no longer causes exceptions.
• Adding new Eclipse RSE connections no longer results in Eclipse emptying the MFA registry entries

when you close the IDE.

• MFA now supports a new configuration parameter JES_CONCHAR for installations that do not use the
default '$' character for JES console commands.

3142873 (1113084)
• When performing a delete from the JES spool first check if the user is the owner. If true then allow the

delete to proceed, else check the normal RACF JESSPOOL and JESJOB classes to determine if the
user is authorized to perform the action. If no JESSPOOL or JESJOB classes are present then deny.

3141208 (1113585)
• An occasional 0C4 in DCPSAF caused by a memory overwrite has been fixed.

3129416 (1111732)
• MFDAS import requests made to Endevor now honour the PGRP (processor-group) parameter.

3127644 (1111509)
• The Endevor transient data set allocated to ENDVLIST has had its maximum space allocation increased

to enable handling of large history listings.

3122295 (1110989)
• A program using the ACCEPT FROM SYSIN statement to read a data set on the mainframe failed to

release the data set when the step had completed. The data set remained locked to the Data Connect
mainframe process. This has been fixed.

3122245 (1110995)
• Previously, when updating an Endevor element with a workstation file containing zero-length records

they were always treated as updates. Writing at least one blank now avoids this and no update takes
place.
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3105518 (1109752)
• The file handler was sending a function code that was not recognised by MFA causing an abend 0C4.

This has now been fixed.

3105465 (1109897)
• Default parameters in the PARMS member where incorrectly set. These have now been restored to the

defaults as documented.

• The command line utility MFMON2 will now exit and return an error message if it is unable to create the
temporary files it requires to run.

3123995 (1111268)
• The MFA Synchronisation and Control Monitor did not correctly synchronise mainframe datasets whose

members contained a $ character.

3121666 (1110909)
• The compare and synchronization monitor command line utility MFMON2 was failing if more than 4000

files were synchronised. This has been fixed.

3104574 (1109235)

• An abend 02A will no longer occur if submit and PDS hash functions execute at the same time.

3135556 (1112256)
• User code now runs in an independent address space in the Mainframe Call Generator. It previously ran

in the Mainframe Access address space meaning it was technically possible for the code to enter
supervisor state. MCGLIB now becomes the new address space's STEPLIB so other user modules can
be called from the first one without placing them in MFA's STEPLIB.

2120159 (1057612)

Micro Focus Batch Scheduler Integration

Back to the list

• %%INCLIB Control-M statements, used in a conditional block (%%IF, %%ELSE, and %%ENDIF), are
now executed or skipped as expected.

3128402 (1111552)
• By default, performing a soft-kill on an MFBSIJCL process that is waiting for JOB termination also

cancels the JOB in Enterprise Server before terminating. Use the following parameter in the MFBSI
configuration file to avoid killing the JOB when the process is soft-killed: ES_JOB_KILL=NO (By default,
ES_JOB_KILL=YES is assumed.)

3120998 (1110950)

Micro Focus Cryptographic Library

Back to the list

• The MFDS could crash during startup when SSL and a keyfile with no password are used to secure it.

3152964 (1113791)

Monitoring and Management

Back to the list

• JCL jobs that generate STEPBYPASSED events no longer cause incorrect values in JCL HSF records.

2886646 (1108200)
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OLE Class Library

Back to the list

• An issue with the tabbing of ActiveX controls has been resolved.

3106202 (1109437)

OO Base Class Library

Back to the list

• The SortedCollection class methods setSortMethod and setSortEntry are now thread-safe.

3145921 (1113207)
• The class libraries resources now compile without having to add the Windows SDK include location to

the INCLUDE environment variable.

3117380 (1110512)
• Menu item objects are not destroyed until the on idle processing. This is to stop the destroying from

being attempted twice.

3107820 (1110204)

PL/I Support

Back to the list

• "-optexec plitest" is now correctly honored with margins 1,72 (and others).

3140040 (1112694)
• Calls to functions with CHAR VARYING BIGENDIAN parameters now compile correctly when using -

OPT.

3151487 (1113707)

• A PL/I compiler optimization problem using the compiler options -opt -range causing incorrect execution
behavior has been fixed.

3151588 (1113704)
• Previously, you could encounter issues when using factored declarations of named constants.

3151490 (1113657)
• The use of condition prefixes no longer causes diagnostic message MFPLI04042A.

3151488 (1113713)
• An issue which caused a message "MFPLI04042A : Possible compiler error" has been resolved.

3151486 (1113705)
• The Open PL/I compiler now handles the SUBSTR built-in during restricted expression evaluation.

3150937 (1113615)
• The Open PL/I compiler now handles the COLLATE built-in during restricted expression evaluation.

3150936 (1113614)
• A problem with static structure members initialized with ADDR(x) where "x" is another static variable

has been fixed.

3150240 (1113577)
• Using a condition prefix of SIZE, and built-in VERIFY, no longer causes a compiler abort.

3146621 (1113244)
• Open-PLI now supports the XMLOMIT and XMLATTR attributes.

3140927 (1112923)
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• The PICSPEC built-in function is now supported.

3140470 (1112889)
• Conversion of float dec to fixed dec now works correctly when using -fdmaxp 15.

3139170 (1112562)
• Open-PLI now supports the use of a named constant in the FROM clause of a WRITE statement.

3139145 (1112792)
• The message "MFPLI00069S : An arithmetic constant must be separated from the following symbol by

a delimiter. A blank delimiter has been supplied." has been reduced to Warning Level.

3139138 (1113106)
• Open PL/I now supports the NONASSIGNABLE attribute.

3139137 (1112687)
• The severity of message "MFPLI01267E : The resultant size of the STRING built-in is > the

implementation limit of 32K" has been reduced to Level-E.

3139136 (1112704)
• The error diagnostic of ADDR built-in function when used with FIXED BIN(8) UNSIGNED data type no

longer occurs.

3139135 (1112660)
• A problem when REFER is used in a LIKE structure has been fixed.

3139131 (1112686)
• The Open PL/I compiler now evaluates the NOT ^ operator when applied to bit strings in a named

constant VALUE clause as part of restricted expression evaluation. The maximum length of a bit string
in this case scenario is 32764.

3139125 (1112615)
• A new compiler option, -fdcheck, is available. It checks any direct assignment and passing of FIXED

DECIMALS variables using dummy argument for loss of possible digits. When used in combination with
–nofdcheck, the options -cics, -sql, -dli, -mvs, and/or –ims imply –fdcheck can be overridden.

3137471 (1112414)
• An erroneous diagnostic MFPLI00132E has been corrected.

3136427 (1112344)
• Open PL/I now supports the COMPARE built-in function.

3136266 (1112293)
• A problem with STATIC INIT(ADDR(x)) where "x" is a static internal ENTRY constant has been fixed.

3136219 (1112285)
• Open PL/I now supports the EDIT built-in function.

3136123 (1112277)
• Open PL/I now supports the SOURCEFILE and SOURCELINE built-in functions.

3136081 (1112273)
• The OPTIONS(VARIABLE) clause is no longer required on an entry declaration with no descriptor list

when optional arguments are omitted at invocation.

3136001 (1112259)
• PL/I declarations of UNSIGNED BIN (FIXED attribute omitted) now correctly resolve to UNSIGNED

FIXED BIN.

3135879 (1112245)
• A problem with STATIC INITIAL(ADDR(x))applied to a structure member has been fixed.

3135757 (1112234)
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• Open PL/I now supports an optional DATETIME format pattern.

3135480 (1112210)
• Open PL/I now supports the CURRENTSIZE built-in.

3134967 (1112163)
• Open PL/I now supports the RESIGNAL statement.

3134389 (1112120)
• Open PL/I now supports the ITERATE statement. Restriction: ITERATE with multiple comma-separated

DO controls is not supported.

3134386 (1112119)
• The Open PL/I compiler now generates string range diagnostic errors on SUBSTR arguments which

can be evaluated at compile-time. In addition, when -range or the prefix condition stringrange is in
effect, runtime range checking is eliminated for SUBSTR operands known to be in range at compile-
time.

3130920 (1111808)
• An extraneous comma preceding a semi-colon which terminates a structure declaration now causes the

compiler to generate an Info-Level diagnostic.

3112934 (1110069)
• The compiler (ED 4.0) now supports –margini (‘c’) – where ‘c’ is a character which delimits the left and

right margins in the source listing. The option –margins is required for this option to take effect.

3102178 (1109027)
• A new compiler option -nolaxif is now supported. See the User's Guide for more information.

2884542 (1108177)
• The CELL attribute is now supported as synonym for UNION.

(629286)
• The CONSTANT attribute is now supported on FILE and ENTRY data types.

(629298)

• A problem where a null-based variable was causing a SIGSEGV while calling PLIDUMP has been fixed.
The variable will be omitted from the PLIDUMP output.

3130827 (1111814)
• Previously, when trying to read the memory for a variable evaluation, PLIDUMP would crash. Now, it

recovers and prints out a message.

3130827 (1112244)
• When waiting for an attachment while debugging a PL/I code application running in Enterprise Server,

the remote debugger would not shut down.
• An issue has been resolved where after a notification mfplictx was also loaded which confused the

debugger.
• 64-bit debugging can now be stopped without any issues.
• While shutting down, the debugger was attempting to free the languageContext variable and that was

causing the debugger to crash. This no longer occurs.
• A conditional breakpoint is executed when the results of an expression are TRUE. An expression can be

a simple variable value check such as: foo = 'This is a simple string' foo_number = 9 bar = '"This is a
quoted string"' The following is an example of a more complex expression: foo = 'This is a simple string'
& foo_number = 9 You can also use one of the PL/I functions supported by the debugger. For example:
substr(foo, 1, 7) = 'This is' See Codewatch User's Guide > Codewatch Commands > Breakpoints >
Conditional Watchpoints in your product help.

• An issue where PL/I Wait for attachment would not stop waiting has been resolved.
• Previously, when trying to run-to-line on an empty line the debugger would hang. It now gives a

message to the user that it is an invalid line.
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• The cwnotif.dat file is no longer required for CodeWatch to receive notifications from the PL/I run-time
system.

• The PLI MQ headers cmqepp.inc and cmqp.inc now contain the bigendian attribute in all fixed bin fields.

3151579 (1113666)

• Previously, if using mixed case or lowercase to write *PROCESS statements and -margins 2,72 was in
effect, the macro preprocessor would strip the * and leave the word PROCESS in place causing compile
errors.

3136423 (1112356)
• A problem related to the generation of macro output when a macro procedure specified an argument

but the invocation did not utilize an argument has been corrected.

3131736 (1111905)
• Previously, the PL/I macro preprocessor when invoked as part of the Eclipse Editor background parse,

ran unacceptably slow if there were large amounts of source code with no intervening preprocessor
statements. This no longer occurs.

3110545 (1109838)
• Previously, when using the PL/I Macro Preprocessor's %NOTE built-in function, the message was

output in a non-standard format. It now emits an informatory message MFPP09073I followed by a single
character indicating the severity (I,W,E,S) based on the "condition code" that %NOTE was driven with,
and then the %NOTE Text.

3109720 (1109996)
• A fix for RPI 1109323 had an unintended knock-on effect with regard to to the PARMSET built-in

function when used against a variable that was not passed into a user's PL/I Macro procedure. This no
longer occurs.

3109342 (1109765)
• Previously, if referencing a macro which had been declared, but not defined, the macro preprocessor

took a SIGSEGV trying to invoke the macro. This no longer occurs.
• Bit strings evaluated as part of a PL/I Macro Expression were not evaluated correctly when using the

new -case_asis option.
• Previously, if -margins 2,72 were used and the program split a fully qualified variable name that

exceeded 70 bytes in length at the right margin, then an infinite loop occurred in the macro
preprocessor. This no longer occurs.

• Previously, if trying to use EDz to edit PL/I code on the mainframe without a PL/I Dev and PL/I RTS
License caused the IDE to crash. This no longer occurs.

• The NOSCAN option of the ANSWER statement is now honored.
• Previously, the PL/I Macro Preprocessor did not correctly identify *PROCESS; as a valid *PROCESS

statement. This caused problems when multiple macro passes were made against the same source
with -margins 2,72 in effect.

• PL/I Macro preprocessor now accepts OTHER as an abbreviation for OTHERWISE when SELECT is
used in a PL/I Macro.

• Previously, if a null keyword was used in a macro with the STATEMENT attribute and it was then
followed by a non-null keyword value, Enterprise Developer issued a diagnostic message and used the
"null" keyword value. In this scenario, IBM uses the following non-null keyword value. The behavior of
Enterprise Developer now matches IBM's.

• Previously, when using the macro preprocessor to replace a variable in your code, if the value of the
variable contained the name of the variable, the process went into an infinite loop until the stack was
exhausted. The default behavior of the Micro Focus macro preprocessor has now been changed to
match the behavior of IBM's default macro preprocessor option of RESCAN(ASIS) in such scenarios.

• Previously, there was no easy way to determine if a PL/I Shared object built under Enterprise Developer
was being executed against an incompatible version of the PL/I Runtime. The version information is now
emitted in a CTF Diagnostic to facilitate troubleshooting.
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3148585 (1113576)
• Previously, if a PL/I program was pre-compiled with -sql db2 precompiler and it implicitly opened

SYSPRINT on two consecutive jobsteps, the second jobstep would trap. This no longer occurs.

3144431 (1113098)
• An RTS115/U4038 abend no longer occurs when -pic is used in conjunction with memory strategy

being enabled.

2832375 (1101037)

• A problem checking the overlay of based variables (-nolaxbased) has been fixed.

3142680 (1112902)
• "-optexec plitest" is now correctly processed honoring plitest when margins 1,72 (and other settings) are

in effect.

3141474 (1112780)
• Previously, the HCO pre-compiler didn't handle XMLPARSE correctly which resulted in compile failure.

This has now been fixed.

3109344 (1110210)
• Previously, when the macro preprocessor was used in conjunction with other preprocessors, it added

%IGNOREMARGINS; to the generated source and then emitted code between 1 and 254. In the
customer-supplied scenario where a EXEC SQL INCLUDE was used and it had information in columns
73-80, it caused a failure to compile. The new behavior is that the intermediate code is emitted within
the specified margins and the margins setting is passed to all preprocessors and the compiler.

3106330 (1109782)

Run-Time System

Back to the list

• IBM floating-point behavior is now supported in managed code via the MAINFRAME-FLOATING-POINT
Compiler directive.

3111511 (1109931)

• When native COBOL calls a Java method that returns an array of objects, the returned object reference
now correctly represents the array of objects.

3144462 (1113127)
• When creating a live recording file, if you specify a path in the COB_LIVE_RECORD environment

variable, the path is now validated (to ensure it exists) before the process runs.

3136927 (629611)
• A new tunable has been introduced, dbcs_text_enable_clip, which when set to true ensures that the font

is clipped to the font height supplied by Microsoft Text APIs rather than overwriting pixels beyond the
font height. Use this tunable when running in a GUI window (runw). The default is false.

3136924 (1112338)
• The NUMPROC"ACOS" directive has been enhanced to support certain elements of NEC ACOS

COBOL relating to the processing of invalid data in USAGE DISPLAY data items.

3135821 (1112242)
• A bug in the NUMPROC"ACOS" emulation of NEC ACOS COBOL has been fixed. The error occurred in

statements of the form: move unsigned-display-item to numeric-edited-item where the source item
contains a negative value.

3135821 (1113569)
• The NUMPROC"ACOS" directive has been enhanced to support certain elements of NEC ACOS

COBOL relating to invalid sign information in USAGE COMP-3 data items.

3135820 (1112241)
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• In the run-time text window, the correct key-code is now returned when the Tab key is pressed after the
Window menu has been previously selected using the Alt + Space shortcut.

3132989 (1111983)
• The position and size of windows created with the WINDOW-CREATE clause in Dialect(RM) will no

longer be constrained by the window that was active when the call is made. Previously, a window
created by WINDOW-CREATE would be required to fit within the constraints of the parent window. This
behavior was not consistent with the same command under RM/COBOL, and so was changed.

3131065 (1111843)
• A GUI application no longer fails to terminate correctly if the title bar of the text window console is

currently selected with the mouse when the termination occurs.

3124823 (1111218)
• OO CTF tracing now correctly outputs the thread-id to file.

3117361 (1110510)
• When using .INT code, an arithmetic statement involving a 64-bit COMP-5 operand now gives the

correct results.

3111631 (1109997)
• When entering multiple DBCS characters using the IME, the later characters in the string are no longer

being corrupted. Previously, corruption occurred due to a bug in Microsoft's ReadConsoleInput() API.

3111356 (1109909)
• A new parameter is available for the CHECKDIV Compiler directive that emulates behavior when

attempting to divide by zero on an ACOS mainframe system. CHECKDIV"ACOS" will result in both the
quotient and the remainder being set to the value of the dividend if a divide by zero operation is
attempted when no ON SIZE ERROR clause is specified.

3111073 (1109890)
• The NUMPROC Compiler directive has a new parameter. NUMPROC"ACOS" provides partial

compatibility with the behavior of NEC ACOS COBOL processing of invalid data in USAGE DISPLAY
data items.

3111072 (1109889)
• On file systems that support 64-bit inode numbers, CTF output files were not produced in the expected

directory if its inode number was sufficiently large that it did not fit in 32 bits. This has now been
corrected.

3109110 (629772)
• When using the COBOL printer routines, the default printer is now selected on Windows Server 2016.

Registry differences introduced with Windows 10/Sever 16 caused existing functions to select the wrong
default printer. These have now been updated to use an alternative method to achieve the correct
result.

3109043 (1110153)
• An intermittent runtime error (COBRT255: CODESET cannot open double byte conversion table) could

occur when MFCODESET was set to a value that included double byte conversions. This has been
fixed.

3108885 (1109915)
• The correct status-code definitions (for Windows and UNIX) are now recorded in the documentation.

2879887 (1107243)
• Improvements have been made to the run-time system, the File Handler and the JCL engine, with

regards to error trapping and reporting.

2867927 (1106202)
• Spurious errors no longer occur when compiling or running programs on 32bit Linux platforms with an

XFS file system greater than 1TB.
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• COBUTF8 no longer segfaults if COBDIR is not set.

Setup Issues

Back to the list

• Installing release 3.0 on a machine where there was a 4.0 product installed and then uninstalled, could
result in issues with package loading in Visual Studio.

3152508 (1113755)
• The DemoCA installer now works correctly on Japanese OS.

3142481 (1112900)
• The file associations for Open PL/1 and COBOL project files in Visual Studio are now configured

correctly.

3123600 (1111117)
• An issue with some empty folders created during installation ad not deleted when the product was

uninstalled has been resolved.

3115392 (1110376)
• The versions of the installers for HotFix updates of Enterprise Server for .NET are now incremented for

each new HotFix.

2991064 (1108772)

HCO for DB2 LUW

Back to the list

• The DB2 preprocessor sometimes generated a 309 malformed subscript error if the SQL statement
contained COMP host variables with an indicator variable array. This has been fixed.

3142686 (1112952)
• A problem that prevented the use of CBLLINK on compiled programs that use LITLINK has been fixed.

HCO now supplies the LIBs necessary to link these applications. Note: If you compile static DB2
applications that use LITLINK, you must compile them using the DB2(NOPRE) directive, and specify all
applicable LIBs in the LINK statement. For example: CBLLINK SELECT.obj DB2API.LIB,
MFHCOLIB.LIB, MFSQLSMF.LIB

3135847 (1112270)
• The DB2 preprocessor incorrectly generated code to convert COMP fields in SQLCA if no SQL

statement was found in the program. This resulted in error "COBCH0002 Undefined ECM error. Inform
Technical Support. Error code 309". This issue has been resolved.

3129362 (1111619)
• The DB2 preprocessor has been enhanced with a new directive option, DB2(STOPROC), that provides

a solution to a problem that prevented DB2 LUW stored procedures from working properly when
compiled with CHARSET(EBDIC) because character information is passed to and from DB2 LUW as
ASCII data.

3129260 (1111614)
• A problem that caused the DB2 preprocessor to generate DB103 errors on mainframe-style VARCHAR

host variable definitions has been fixed.

3123813 (1111337)
• When run against DB2 LUW version 10 or later, the HCO DCLGEN tool sometimes defined the first

column in a DECLARE TABLE statement incorrectly by dropping WITH DEFAULT. This has been fixed.

3119616 (1110699)
• The DB2 preprocessor and HCO runtime have been updated to convert an entire VARCHAR field to

EBCDIC rather than just converting the length of data specified. This corrects a problem with erroneous
ASCII spaces showing up in VARCHAR columns.
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3110220 (1109819)

SQL: HCO for SQL Server

Back to the list

• When using HCOSS Generate DDL to generate tables and columns from mainframe code that
contained REMARKS containing single-quote characters, a SQL Server DDL syntax error occurred. To
correct this, REMARKS are now generated using two single-quote characters in place of each single-
quote character found in the mainframe code.

3137298 (1112507)
• A problem that occurred when using the HCOSS Generate DDL tool generate unique filtered indexes

with nullable columns caused the columns to be generated incorrectly. This has been fixed such that the
columns are now generated using a WHERE <column_name> IS NOT NULL clause. In addition,
nullable columns defined in unique indexes were not being evaluated with regard to adding the WHERE
NOT NULL clause. This has been fixed as well.

3107289 (1109778)

• The HCOSS DB2 grammar was erroneously generating a syntax error when the mainframe character
STRIP function was used with the BOTH option. This has been fixed.

3140519 (1112698)
• HCOSS data transfer was failing if more than one version of SQL Server was installed on the machine.

This is now fixed.

3132833 (1111996)
• When using SQL(DIALECT=MAINFRAME) the STRICTPARSE directive is now set by default, and can

be disabled by specifying NOSTRICTPARSE. This is a change from earlier releases in which the default
setting was NOSTRICTPARSE.

SQL: MBDT Utilities

Back to the list

• DSNUTLB LOAD no longer gives an SQL error for columns that are defined as DECIMAL EXTERNAL
and that have a POSITION clause containing only a start position, but no end position.

3139744 (1112632)
• A problem when that occurred when querying referential integrity information for a table has been fixed.

In addition, a problem with CompiliOptionBlock being out of sync with new ESQL directives has been
fixed.

3119350 (1111458)

SQL: OpenESQL

Back to the list

• OpenESQL now supports RETURNING clauses in INSERT, UPDATE and DELETE statements when
using SQL(DBMAN=ADO) and SQL(PROCOB).

3120916 (1110849)
• A problem when using an Oracle REF CURSOR in managed code that sometimes caused subsequent

statements to fail has been fixed.

3113118 (1110287)
• Problems with DATE and TIMSTAMP handling when using the Oracle fully managed provider for

ADO.NET have been fixed by introducing new environment variables to control .NET formatting of
datetime and datetimeoffset values when DATE=EXTERNAL is set for Oracle connections.

3108444 (1109632)

Resolved Issues | 65



• Problems with DATE and TIMESTAMP handling when using the Oracle fully managed provider for
ADO.NET have been fixed by introducing new environment variables to control .NET formatting of
datetime and datetimeoffset values when DATE=EXTERNAL is set for Oracle connections.

3107838 (1109570)

• An issue with singleton selects that have no FROM clause but have a WHERE clause has been fixed.

3151028 (1113711)
• A problem that generated an undefined preprocessor error and caused compilation to fail when a literal

of a size greater than 79 characters was used with the SQL LIKE operator has been fixed.

3150466 (1113596)
• Previously, when using SELECT... INTO statements containing a FOR UPDATE clause with PostgreSQL

and MySQL, the pseudo column used for positioned updates was not present in tables. A new
OpenESQL directive, SQL(NOWHERECURRENT), is now available. This benefits PostgreSQL and
MySQL applications that do not require positioned update or delete support, and where the pseudo
column used as a rowid to implement positioned updates and deletes is not present.

3146620 (1113335)
• A problem using "plan" as an SQL identifier has been fixed.

3146620 (1113251)
• An issue with using the SQL(XAID) Compiler directive with IMS applications has been resolved.

3144626 (1113137)
• A problem with applications using a very large number of embedded SQL statements has been fixed.

3142107 (1113006)
• A problem with fetching data into .NET Decimal host variables, causing an invalid overflow error, has

been fixed.

3134510 (1112152)
• A problem handling .NET string host variables in OpenESQL applications compiled with the 64-bit

COBOL compiler has been fixed

3134369 (1112116)
• The file cobmfdsntiar.so is now included in the COBOL Server product.

3132441 (1112164)
• The limit for the number of compiled SQL statements has been increased from 5000 to 12000.

3129084 (1111593)
• An inconsistency with the OpenESQL ADO.NET runtime handling of PIC X host variables in DBCS

locales has been fixed.

3128324 (1111562)
• A problem with EXEC SQL ALLOCATE for SQL-CLOB host variables has been fixed.

3128295 (1111492)
• OpenESQL for ADO has been updated to behave consistently with Pro*COBOL by returning a +1403

SQLCODE instead of an erroneous -1403 SQLCODE when a PL/SQL stored procedure fails to handle
a data-not-found condition.

3128289 (1111491)
• A problem that prevented the setting of the UNSAFE_NULL directive from the IDE when using

Pro*COBOL has been fixed.

3127696 (1111447)
• A problem with Oracle scroll cursors that resulted in a backward compatibility issue with Net Express

has been fixed.

3126245 (1111648)
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• If you use an AT db_name clause in a DECLARE CURSOR statement, you no longer need this clause
in statements that reference the cursor, such as FETCH, CLOSE, GET NEXT RESULT SET or
positioned UPDATE and positioned DELETE statements. To maintain backward compatibility the clause
may optionally be included, but it is no longer required.

3124001 (1111150)
• A problem that caused the OpenESQL preprocessor to generate invalid code when "AT xxxx SELECT"

was specified in an array singleton SELECT statement in managed code has been fixed.

3123827 (1111128)
• A problem with SQL(CHECK) that was introduced in version 3.0 of this product and occurred for DB2,

Oracle, and PostgreSQL with ADO.NET has been fixed.

3121267 (1110919)
• A problem using AT <connectionName> with COMMIT, ROLLBACK, and SAVEPOINT statements has

been fixed.

3115063 (1110308)
• A new SQL compiler directive option, PICXBINDING, has been added to OpenESQL to provide more

intuitive behavior for LIKE expressions with SQL Server by enabling greater control of parameter
binding for PIC X host variables.

3113999 (1110373)
• OpenESQL has been updated to retain the FOR READ ONLY clause when the TARGETDB SQL

compiler directive option is set to DB2.

3112785 (1111030)
• A problem with fractional seconds truncation when using the legacy SQL Server ODBC driver has been

fixed.

3112499 (1110032)
• A problem using SYSTEM_USER in select statements has been fixed.

3111513 (1109934)
• A problem caused by OpenESQL rounding a result to a COMP-3 host variable instead of truncating it

has been fixed in the ODBC runtime.

3110902 (1109871)
• A problem with OpenESQL trimming trailing spaces in input host variables has been fixed by the

addition of the SQL(PIXCBINDING=FIXED) compiler directive option, which ensures that these trailing
spaces remain intact.

3110720 (1110099)
• A problem handling unmapped codepoints in DBCS locales when storing binary data in character fileds

and using SQL(ALLOWNULLCHAR) has been fixed.

3109266 (1109723)
• OpenESQL had a storage limit of 30 characters for a program ID. The maximum has been increased to

128 characters.

2884875 (1107982)
• A problem that caused OpenESQL to remove any OPTIMIZE FOR n ROWS clause from queries when

TARGETDB was set to DB2 has been fixed.

2883301 (1108387)
• A problem with HCOSS access plans getting out of sync with the running code and database stored

procedures and metadata when a live ES region is updated has been fixed.

2877693 (1110926)
• OpenESQL has been updated to support the OPTIMIZECURSORS SQL compiler directive option for

the OCI and JDBC run-time systems.
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• The SQL(TRANSACTION) directive now accepts an additional option, AUTO.
SQL(TRANSACTION=AUTO) is equivalent to SQL(AUTOCOMMIT). For new applications,
SQL(TRANSACTION) is the preferred method for specifying transaction options.

• PostgreSQL versions 3.2.2 and later are now supported with .NET COBOL.
• Operating System authentication for CONNECT statements is now supported for Oracle, DB2, and SQL

Server in the ODBC, ADO, and JDBC run-time systems.

SQL Option for DB2

Back to the list

• A problem that caused an AUTOBIND support routine invoked by the XDB ECM to fail by omitting the
drive letter in log file names when the specified drive letter was other than C: has been fixed.

3114069 (1110423)

• The XDB ECM now supports the z/OS DB2 NEXTVAL reserved word as an ordinary identifier.

3120469 (1110834)
• A problem that prevented the SQL Option for DB2 ECM from recognizing IN clause predicates

containing multiple group host variables has been fixed.

3115066 (1110310)
• A problem that prevented the SQL Option for DB2 ECM from supporting the use of a collection ID for

validating SQL against z/OS DB2 with DYNAMICRULES BIND packages has been fixed.

3112996 (1110332)

• A problem reading XDB translation files caused by stack initialization on Windows 10 has been
resolved.

3120927 (1110988)

• A problem that resulted in an X352 thread access violation due to an improper reallocation of the parse
tree when using an inner join to a table expression containing a scalar subquery has been fixed.

3132740 (1111977)
• A problem with CASE expressions resolving host variables has been resolved.

3131966 (1111932)
• A problem with the lexical analysis of a PARTITION BY SIZE clause on a CREATE TABLE statement

when the integer constant and the "G" indicating gigabytes were not separated by a space character
has been fixed.

3129670 (1111676)
• An issue with a correlated subquery not returning results due to a problem with the correlation variable

has been resolved.

3114811 (1110283)
• A problem with the query optimizer incorrectly identifying the step for predicate evaluation of a join

predicate containing a column and an expression has been resolved.

3114809 (1110284)
• A problem that caused an X352 thread access violation on a VIEW definition containing a select item of

the form name.* has been fixed.

3114210 (1110228)
• An access violation caused by a long UNC path for the Roaming APPDATA directory on a Windows

machine has been resolved.

3112201 (1110021)
• A problem that caused the XDB engine optimizer to return an empty result set for range predicates on

join conditions has been fixed.
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3111742 (1109957)
• A problem with the first FETCH operation against a rowset cursor containing a UNION ALL with host

variables has been resolved.

3110071 (1109893)
• An issue with a LEFT OUTER JOIN operation not retrieving all result set rows has been resolved.

3104216 (1109202)
• A problem with XDB engines not allowing a GROUP BY to contain an item not in the projection list has

been fixed.

3103832 (1109175)
• A problem that caused a PDMP272 – xdb Inner Join Problem message has been fixed.

2887796 (1108361)

• The Stored Procedure Test tool now sizes the Results tab in the same way as it sizes the other tabs.

3148319 (1113402)
• A problem with DSNUTILB that occurred when loading a table containing a VARCHAR field has been

resolved.

3128931 (1111587)

XML Support

Back to the list

• cbl2xml will now work successfully under AIX 7 32-bit.

3109051 (1109699)

• The XML run-time now handles UTF-16 XML documents correctly.

3147256 (1113357)
• The XML run-time system now correctly sends the XML instance document as an HTTP POST request

to the URL specified on UNIX platforms.

3145761 (1113163)
• An RTS 164 error (Run-Time subprogram not found) no longer occurs on some very old versions of

Windows when parsing XML.

3142315 (1113028)
• The XML run time now correctly sends the XML instance document as HTTP POST request to the URL

specified.

3135893 (1112298)
• XMLPARSE now returns the full UTF-8 string when XMLPARSE(COMPAT) is specified.

3126921 (1112286)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

• 2879380 (1107250)
• 2881923 (1109518)
• 2913358 (1110961)
• 3145394 (1113143)
• 3142564 (1112892)
• 3129260 (1111765)
• 3117914 (1111288)
• 3143624 (1113310)
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Unsupported Functionality
This section includes information about features or functionality that are no longer supported.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Installation

Before Installing

Downloading the Product
You can download Enterprise Developer from the Product Updates section of the Micro Focus SupportLine
Web site.

On Windows

System Requirements

Hardware Requirements

Enterprise Developer has the following requirements in addition to the requirements of Microsoft Visual
Studio. See the Visual Studio documentation for details of the Microsoft requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM.

The maximum disk space requirements are, approximately:

Enterprise Developer Sentinel RMS License Manager

2.3Gb 75MB

• This includes the space needed to cache information locally so that you can modify the installation
without the original source media.

• The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• You can produce both 32-bit or 64-bit applications with Enterprise Developer installed on a 64-bit
operating system.

• This product can be installed on earlier versions of Windows but it has not been tested on them.

• Support for development on Windows 8 and Windows Server 2012 has been discontinued. These
platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are
supported.
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Software Requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components. A supported version of Microsoft's Visual Studio 2015
or 2017 must, however, be installed in advance.

Note:

• Besides the software listed below, the setup file also installs the 64-bit Java 8 Update 102.
• This product includes OpenSSL version 1.0.2n.

Visual Studio IDE

You must have Microsoft's Visual Studio 2013 Update 5, 2015 Update 3, or 2017 version 15.5 or a newer
one, respectively, installed in advance.

You need one of the advanced versions of Visual Studio listed below or the Visual Studio Integrated Shell
(only supported by Enterprise Developer for Visual Studio 2013):

Professional, Premium, Ultimate or Community Edition (for Visual Studio 2013)
Professional, Enterprise or Community Edition (for Visual Studio 2015)
Professional, Enterprise or Community Edition (for Visual Studio 2017) - see the next section for the
Visual Studio components you must install.

Microsoft's Visual Studio Express Edition is not supported.

If there is no Visual Studio installed on your machine, the setup file will install the Visual Studio Integrated
Shell. Alternatively, you can download the Visual Studio Integrated Shell from the Microsoft Download
Center and install it before you install Enterprise Developer. If you choose to install the Shell, ensure you
run the installer to complete the installation - run vsintshell.enu.exe from the location where you
installed the download.

Note that some Visual Studio features might not be available with the Shell. This includes WCF or the
Visual Studio 2013 Connected IDE experience in the Visual Studio 2013 Shell - the help for more details.

Important:

• A problem with Microsoft's Windows 10 prevents installing the Visual Studio 2013 Shell on that
version of the OS. You must install an advanced edition of Visual Studio 2013 on Windows 10
before you start the installation of Enterprise Developer for Visual Studio 2013.

• Enterprise Developer for Visual Studio 2015 does not support Visual Studio 2015 Shell as the
Shell has a number of restrictions to COBOL development. The Visual Studio 2015 Shell is not
included in the setup for Enterprise Developer for Visual Studio 2015 and before you start the
installation, ensure that there is an advanced edition of Visual Studio 2015 installed on your
machine.

• On Windows 8.1 RT, Windows 8.1 or Windows Server 2012 R2, you must have the Windows
update KB 2919355 before you install Visual Studio 2015. Download KB 2919355 from the 
Microsoft Download Center.

• When installing Visual Studio 2017, ensure you select the Help Viewer component for installing to
ensure you can view the Enterprise Developer product help inside Visual Studio. When you select
components to install in the Visual Studio installer, click Individual components and check Help
Viewer in the Code tools section.

• Code generation issues in Microsoft's 64-bit JIT (just-in-time) compiler delivered as part of .NET
Framework version 4.6 can result in incorrect execution of some COBOL code compiled to .NET.
Version 4.6 of the .NET Framework is currently shipped as default with Visual Studio 2015 and
Microsoft's Windows 10. The problems include incorrect execution of MOVE and STRING
statements applied to alphanumeric operands, and incorrect execution of the ROUNDED phrase
for arithmetic statements.
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Some of these issues only seem to be reproducible in COBOL language applications compiled
to .NET and some can be reproduced in other languages (C# or Visual Basic).

These problems have been reported and acknowledged by Microsoft and it is our belief that they
either have resolutions or are working on fixes for all of them. For further information about these
issues and guidelines on how to disable the latest version of the 64-bit JIT compiler, see RyuJIT
Bug Advisory and Troubleshooting RyuJIT.

As of October 2015, Microsoft have released the following updates that address these issues with
the .NET Framework 4.6:

• Hotfix rollup 3088955 for the .NET Framework 4.6 on Windows Server 2012 and Windows 8 -
see: http://www.microfocus.com/docs/links.asp?vc=mskb3088955.

• Hotfix rollup 3088956 for the .NET Framework 4.6 on Windows Server 2012 R2 and Windows
8.1 - see: http://www.microfocus.com/docs/links.asp?vc=mskb3088956

• Hotfix rollup 3088957 for the .NET Framework 4.6 on Windows 7 SP1, Windows Server 2008
SP2, Windows Server 2008 R2 SP1, and Windows Vista SP2 - see: http://
www.microfocus.com/docs/links.asp?vc=mskb3088957.

• Cumulative update 3093266 for Windows 10: September 30, 2015 (available through Windows
Update) - see: http://www.microfocus.com/docs/links.asp?vc=mskb3093266.

The following software is also required:

• Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.

• Microsoft .NET Framework 4.5.1. This is included with Visual Studio 2013.
• Microsoft .NET Framework 4.6. This is included with Visual Studio 2015.
• Microsoft .NET Framework 4.6.1. This is included with Visual Studio 2017.

Selecting the Visual Studio 2017 components to install

The Visual Studio 2017 installer enables you to customize and only install the workloads and components
that are most suitable for your area of development. For example, you can select the components that are
required for .NET desktop development, ASP.NET Web or C++ development.

Note: The Help Viewer component is not installed by default and must be selected before you start
the Visual Studio installation. This is required in order for you to view the Enterprise Developer
product help.

If not already installed, the Enterprise Developer setup file will install the following components:

• .NET Framework version 4.6.1
• Debugger
• Visual Studio's Help Viewer
• Data services

A number of workloads and components are optional and only required by specific types of applications or
tasks:

• Azure, WCF, Web, WPF or SQL CLR application development.

If you require any of these, you can select them when you start the Visual Studio 2017 installer or, enable
them after completing the installation - see the next section.

Installing Visual Studio 2017 features that are not currently installed

If a feature of Visual Studio 2017 was not installed during the Visual Studio installation, the respective
functionality or the project templates for it are not available. You can install a missing feature in one of the
following ways:

Rerun the Visual Studio installer:
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1. Start the Visual Studio 2017 installer and choose to modify an existing Visual Studio instance.
2. Select the workloads and the components that are missing (for example, ASP.NET and web

development or Help Viewer).
3. Start the Visual Studio installation.

Use the Quick Launch control in Visual Studio 2017:

1. Start Visual Studio 2017.
2. Type the name of the feature in the Quick Launch control - for example, type ASP.NET or Help

Viewer.

A drop-down list with any features matching your search string appears. If the feature is not already
installed, one of the search results will be an option to install it.

Use the Install Missing Feature(s) command in Visual Studio 2017:

1. Start Visual Studio 2017.
2. Click Help > Micro Focus Product Help > Install Missing Feature(s) > Feature Name.

Follow the instructions in the installer to install the missing feature.
3. Alternatively, if a Micro Focus project template requires a Visual Studio feature which is not currently

installed, the IDE displays an information bar with instructions to install the feature.

Internet Explorer 10

Internet Explorer 10 (IE 10) is required by the installation of Visual Studio 2013. If you are installing
Enterprise Developer on a machine that has no Visual Studio 2013 installed, the setup file installs Visual
Studio 2013 Shell provided that IE 10 is installed beforehand. You can download IE 10 from Microsoft's
Web site.

IIS Express

IIS Express is required if you want to use the Web development tools. You can download IIS Express from
the Microsoft Download Center.

Other Requirements

Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Enterprise Developer client and a new licensing server on
the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

See this information on the Product Documentation pages on Micro Focus SupportLine, in the product help
for Enterprise Developer for Visual Studio 2013 (click here), Enterprise Developer for Visual Studio 2015
(click here and Enterprise Developer for Visual Studio 2017 (click here).
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Deployment - running . NET COBOL applications from a network server

Back to Top

For .NET COBOL applications that you run from a network server, the server must have the Microsoft .NET
Framework version 4.5.2 or later and the Microsoft Visual C++ 2017 Redistributable Runtime installed.

Product Co-Existence
• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same

machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements
Before starting the installation you should consider the following:

• If, when you install Enterprise Developer for Visual Studio 2013, the machine does not have Microsoft
Visual C++ 2012 Redistributable Runtime already installed, it is installed as required by Enterprise
Developer. The installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll
files, without digital signatures, into the winsxs directory.

• If, when you install Enterprise Developer for Visual Studio 2015, the machine does not have Microsoft
Visual C++ 2013 Redistributable Runtime already installed, it is installed as required by Enterprise
Developer. The installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll
files, without digital signatures, into the winsxs directory.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

On UNIX

Hardware Requirements
The disk space requirements for Micro Focus Enterprise Developer Unix Components are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Sentinel RMS

license
server

POWER
running AIX

Micro Focus 533 MB 2.13 GB 1.07 GB 41 MB

HP IA Micro Focus 953 MB 3.81 GB 1.90 GB 79 MB

System Z
running Red
Hat Linux

Micro Focus 425 MB 1.70 GB 850 MB 39 MB

x86-64
running Red
Hat Linux

Micro Focus 540 MB 2.16 GB 1.08 GB 50 MB

ppc64le
running Red
Hat Linux

Micro Focus 303 MB 1.21 GB 606 MB 1 MB
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Sentinel RMS

license
server

SPARC
running
Solaris

Micro Focus 519 MB 2.08 GB 1.04 GB 38 MB

x86-64
running
Solaris

Micro Focus 472 MB 1.89 GB 944 MB 33 MB

System Z
running SUSE
SLES

Micro Focus 306 MB 1.22 GB 612 MB 39 MB

x64 running
SUSE SLES

Micro Focus 384 MB 1.54 GB 768 MB 50 MB

ppc64le
running SUSE
SLES

Micro Focus 272 MB 1.09 GB 544 MB 1 MB

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements for Micro Focus Enterprise Developer Unix
Components
These are the software requirements for Micro Focus Enterprise Developer Unix Components:

• The "ed", "sed" and "tar" utilities must be installed and added to the PATH.
• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems

but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• Required libraries for Red Hat and SUSE Linux platforms - The installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product
to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.

Library 32-bit
Library
Name

64-bit
Library
Name

Platform

s390 SUSE 12 Red Hat 6.x Red Hat 7

glibc glibc-*.i686 glibc-
*.x86_64

glibc-*.s390 X X

libgcc libgcc-*.i686 libgcc-
*.x86_64

libgcc-*.s390 X X

libstdc++ libstdc++-
*.i686

libstdc++-
*.x86_64

libstdc++-
*.s390

X X

glibc-locale glibc-
locale-32bit

glibc-locale-2 X

glibc-devel glibc-devel-
*.i686

glibc-devel-
*.x86_64

glibc-devel-
*.s390

X X
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Library 32-bit
Library
Name

64-bit
Library
Name

Platform

s390 SUSE 12 Red Hat 6.x Red Hat 7

elfutils-libelf elfutils-
libelf.i386 or
elfutils-
libelf.i686

elfutils-
libelf.x86-64

N/A X X

libelf-devel elfutils-
devel.i386 or
elfutils-
devel.i686

elfutils-
devel.x86-64

N/A X X

libelf-devel libelf-
devel-32bit-0
.137-8.19

libelf-
devel-0.137-
8.19

N/A X

libelf1 libelf1-32bit-
0.137-8.19

libelf1-0.137-
8.19

N/A X

gcc2 gcc*.i686 gcc*x86_64 X X X X

ld2 Binutils*.i686 Binutils*x86_
64

X X X X

• ¹ On SUSE 12, you can only install the 64-bit version of Enterprise Developer. The glibc-locale-32bit
library is still required by the SafeNet Sentinel licensed components.

• * Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the
GNU Project Debugger) can be installed from the install media for your OS.

• ** Operating system libraries required for PL/I support on both SUSE and Red Hat.
• 2 On Red Hat these libraries are required to enable COBOL and PL/I to compile.
• Libraries marked with an 'X' are not included in the platform and need to be installed separately.

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons 
true

Additional Software Requirements for Micro Focus Enterprise
Developer Unix Components
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

See this information on the Product Documentation pages on Micro Focus SupportLine, in the product help
for Enterprise Developer for Visual Studio 2013 (click here), Enterprise Developer for Visual Studio 2015
(click here), and Enterprise Developer for Visual Studio 2017 (click here).

UNIX and Linux Installer Issues

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
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ID must be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.

Installing
Note:

• This version of the product is a full install.
• See Before Installing first for important information. Also, see Installing as an Upgrade, if you have

an earlier version of Enterprise Developer installed on your machine.

To install this product:

1. Run the edvs2017_40.exe file and follow the wizard instructions to install the prerequisite software
and the product.

The installer installs Enterprise Developer, Enterprise Server for .NET, and offers to install Micro Focus
Rumba. The setup file will also install any missing prerequisite software as listed in the topic Software
Requirements.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.
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• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.

Installing Micro Focus Enterprise Developer Unix
Components

Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_4.0_platform

2. Run the installer from the Process User ID login:

./setup_entdev_4.0_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_entdev_4.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:
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• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing and licensing Micro Focus Rumba - available in the product Help and on the Product

Documentation pages on Micro Focus SupportLine
• Installing the Mainframe Components - available in the product Help and on the Product Documentation

pages on Micro Focus SupportLine
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and on the Product

Documentation pages on Micro Focus SupportLine

See this information on the Product Documentation pages on Micro Focus SupportLine, in the product help
for Enterprise Developer for Visual Studio 2013 (click here), Enterprise Developer for Visual Studio 2015
(click here), and Enterprise Developer for Visual Studio 2017 (click here).

On Windows

Installing as an Upgrade
Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the
product you have installed on your machine.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

• Enterprise Developer 4.0 for Visual Studio 2017 cannot upgrade an existing installation of Enterprise
Developer 3.0 or earlier. You need to uninstall the existing product before you can install release 4.0

• Visual Studio 2012 is no longer supported so it is not possible to upgrade to release 4.0 from Enterprise
Developer for Visual Studio 2012 3.0 or earlier.

Enterprise Developer Installation Options
To install Enterprise Developer you run edvs2017_40.exe which contains a number of product .msi files
(Windows Installer packages). When run, edvs2017_40.exe performs some initial system checks then
sequentially installs the .msi files.

edvs2017_40.exe can take a number of parameters, enabling you to specify a number of different types
of installation:

• Standard Installation

Format:
edvs2017_40.exe

Summary:
Full installation including License Manager and Enterprise Developer. During installation you can
specify options including the location to which the components are installed.

• Non-interactive Installation

Format:
edvs2017_40.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation
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Format:
start /wait edvs2017_40.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
start /wait edvs2017_40.exe /q InstallFolder=d:\otherdirectory

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Developer is installed to d:\otherdirectory.

Format:
start /wait edvs2017_40.exe /q RumbaCheckbox=1

Summary:
Full installation of Enterprise Developer and of the Micro Focus Rumba component. All components
are installed non-interactively with no user interface.

To see what parameters you can use, execute the following from the command line:
edvs2017_40.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

Installing Enterprise Developer into Visual Studio 2017
Visual Studio 2017 is offered in different editions, Professional, Enterprise or Community Edition, that can
all co-exist on the same machine. When you install Enterprise Developer, its setup file installs it into any
edition of Visual Studio 2017 (version 15.5 or newer) installed on the machine, including Preview versions.

If, after Enterprise Developer is installed, you install a different edition of Visual Studio 2017, you can use
the MFVSIXINSTALL utility (available in the Enterprise Developer installation directory) to plug Enterprise
Developer into that edition.

MFVSIXINSTALL

To install Enterprise Developer in all editions of Visual Studio 2017:

1. Locate MFVSIXInstall.exe in %ProgramFiles(x86)%\Micro Focus\Enterprise
Developer\vsix.

2. Run MFVSIXInstall.exe.

This starts the VSIX Installer utility that will install all the required components into the existing editions
of Visual Studio 2017.

3. Click Modify in the VSIX Installer dialog box to start the installation.
4. Click Close when the installation is completed.

You can execute MFVSIXInstall.exe from the command line with different parameters. For example, to
uninstall Enterprise Developer from all editions of Visual Studio, execute MFVSIXInstall -u.

For a list of all parameters execute MFVSIXInstall -?.
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Troubleshooting Enterprise Developer installations

You can use the MFVSIXInstall utility to troubleshoot and fix any issues with plugging Enterprise Developer
into Visual Studio.

If after installing Enterprise Developer there appears to be no Enterprise Developer support in Visual
Studio, run the MFVSIXInstall utility as described earlier. The utility provides information about any issues
that were found and will, in most cases, fix the Enterprise Developer integration.

In some cases, an issue with the Enterprise Developer installation might be caused by an issue with Visual
Studio setup itself. You need to run the Visual Studio installer that will report any potential problems and
enable you to either repair, modify or uninstall the IDE. If the installer reports any issues, check the
following for more details:

On UNIX

Installing as an Upgrade
This release works concurrently with the previous version of Micro Focus Enterprise Developer Unix
Components, so you do not need to uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Micro Focus Enterprise Developer Unix Components installer with the –installlocation option:

1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Micro Focus Enterprise Developer Unix Components Installation
Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_4.0_platform -installlocation="full path of new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.
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Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

–silent -IacceptEULA

For example, execute:

setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus SupportLine Web site for any updates to

the documentation which might have been uploaded.

On Windows

Starting the Product
You are now ready to run Enterprise Developer:

Windows 8.1 • From the Windows Start screen, click the Visual Studio 2017 tile.
• From your Windows desktop, click the Visual Studio 2017 tile.

Windows 10 and
Later

• From your Windows desktop, click Start > Micro Focus Enterprise Developer >
Visual Studio 2017.

• From your Windows desktop, click Start > Visual Studio 2017.

Viewing the Product Help
To view the documentation installed with your product:

1. Start Visual Studio.
2. Ensure that the Visual Studio Help Library is pointing to local help - from the Visual Studio menu click

Help > Set Help Preferences > Launch in Help Browser.
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3. Click Help > View Help.

This opens the product help in Microsoft's Help Viewer.

For full details of the Visual Studio Help system, see the MSDN.

If, after Enterprise Developer was installed, you do not see its product help in the Help Viewer, you need to
install the documentation manually as follows:

1. In Visual Studio 2017, ensure the Visual Studio Help Viewer is installed.

See Installing missing components of Visual Studio 2017 in Software Requirements for instructions on
how to install it.

2. Start Visual Studio.
3. Click Help > Add and Remove Content.

This starts the Microsoft Help Viewer.
4. Click the Manage Content tab and click Disk.
5. Click the browse button next to Disk and navigate to the %ProgramFiles(x86)%\Micro Focus

\Enterprise Developer\Help folder.
6. Select helpcontentsetup.msha and click Open.

This loads the Enterprise Developer documentation.
7. Click Add and then Update.

After the installation is complete, the Enterprise Developer product Help appears in the Help Viewer.

Note: On some Windows versions such as Windows 8 or Windows Server 2012, an issue with
Microsoft Help Viewer and Internet Explorer's security being turned on can cause the Help content to
be displayed as raw HTML code. To resolve the issue, you need to turn off the Internet Explorer
Enhanced Security Configuration (IE ESC) for both administrators and users. Check the Microsoft
Windows help for more information on how to do this.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Enterprise Developer
does not automatically uninstall Enterprise Server for .NET, the Micro Focus License Administration
or any of the prerequisite software.

Enterprise Server for .NET must be uninstalled before you remove Enterprise Developer. To
completely remove the product you must uninstall the Micro Focus License Administration as well.
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You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile

On UNIX

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper4.0.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To start Micro Focus License Administration

Windows 8.1 • From the Windows Start screen, click the License Administration tile

Windows 10 and Later • From your Windows desktop, click Start > Micro Focus License Manager >
License Administration

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a string
of 16 alphanumeric characters.

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Enterprise Developer.
2. Click Help > Micro Focus Product Help > Product Licensing to open the Product Licensing dialog

box.
3. Ensure I have a full Enterprise Developer Team Edition license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click Authorize to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.
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If you have an authorization code

Authorizing your product when you have an Internet connection
Note:

• It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Support Resources > All Support Resources. In the Browse by Product
field, click the product you require support for. Click Log into SupportLine.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
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(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.

To run MFSupportInfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer
© Copyright 2019 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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